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Introduction 
 

 เนื้อหาภายในหนังสือคูมือ The examples of CP-JR51USB v1.0 นี้ภายในประกอบไป
ดวยตัวอยางโปรแกรมที่เขียนดวยภาษา Assembly, สําหรับรองรับ Hardware ตางๆ ของบอรด 
CP-JR51USB v1.0 นี้  

 

 สําหรับผูสนใจการเขียนดวยภาษา C ( Keil ) ผูอานสามารถเขาไปดูตัวอยางโปรแกรม
ไดที่เวปไซด  

 

 http://www.atmel.fi/dyn/products/product_card.asp?part_id=3011 
  http://www.keil.com/dd/chip/3533.htm 

 
ซึ่งภายในเวปไซดเหลานี้จะมีตัวอยางโปรแกรมทั้งภาษา C และ ภาษา Assembly มากมายใหผู
อานไดศึกษา ดังนั้น ผูเขียนจะไมขออธิบายในหนังสือคูมือนี้ 
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การใชงาน Port บน AT89C5131 
 

  

 การใชงานกับพอรต P0 จนถึง P3 นั้นจะเหมือนกับ มาตรฐาน 8051 ปกติ ซึ่งผูอานสามารถหาอานรายละเอียดได
จากหนังสือทั่วไป ในสวนของพอรต P4 จะใชเปนการส่ือสารแบบ Two Wire Interface ( TWI ) หรือ I2C  

 
Examples 1:  [ P0.asm ]  โปรแกรมนี้เปนการใชงานพอรต P0 เพ่ือขับ LED ใหเปนไฟวิ่ง โดยผูอานจะตองตอ 
Hardware ไวที่พอรต P0 ดวย  
 

 
 
 
 
 
 
 
 
 
 
 



                       The Examples of CP-JR51USB V1.0      

 ETT CO.,LTD.                                       2                                     WWW.ETT.CO.TH  

 
 

 
 
 
 
 
 
 
 
 
 
 
 

;********************************************************************* 
; DESCRIBTION : THIS PROGRAM IS ROTATE RIGHT OF PORT 0  
; FILE NAME   : P0.ASM 
; COMPILER    : CROSS 32 
; SUPPORT     : AT89C5131 
; DATE        : 7 August 2004 
;********************************************************************* 
 
 CPU "8051.TBL" ; Processor declaration 
 HOF "INT8"  ; Intel 8-bit hexcode 
 INCL    "AT89C5131.SFR"  
 
;*********************************** 
; DEFINE 
;*********************************** 
DATA    EQU 0FEH 
;*********************************** 
 
 ORG 0000H   ; Reset vector 
 ANL CKCON0,#11111110B ; SYSTEM CLOCK = 12CLK/MACHINE 
; ORL CKCON0,#00000001B ; SYSTEM CLOCK = 6CLK/MACHINE 
START: MOV A,#DATA  ; DEFIND FIRST VALUE      
LOOP:  RR A 
       MOV P0,A 
 ACALL DELAY 
 SJMP LOOP 
 
;************************************ 
; DELAY 
;************************************ 
DELAY:  MOV   R2,#100 
L1:     MOV     R3,#50H 
L2:     MOV     R4,#5H 
        DJNZ    R4,$ 
        DJNZ    R3,l2 
        DJNZ    R2,L1 
   RET 
        END 
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คําอธิบาย 
 

 โปรแกรม  P0.asm นี้ เปนโปรแกรมไฟวิ่งออก
ทางพอรต P0 ซึ่งจากโปรแกรมดานบน จะมี คําส่ัง ANL 
CKCON0,#11111110B ซึ่ ง ทํ า ห น า ที่ กํ า ห น ด ให  1 
Machine cycle นั้นใชเวลา 12 clock , ในสวนของการ
กําหนดให LED เลื่อนนั้นจะเปนหนาที่ของคําสั่ง RR A  

 

 ในการเขียนโปรแกรมทุกครั้ง, ผูอานควรจะใช 
คํ าสั่ ง  ANL CKCON0,#11111110B  ( 12clk/M ) ห รือ  
คําสั่ง ORL CKCON0,#00000001B ( 6clk/M ) ทุกครั้ง 
เพ่ือปองกันความผิดพลาดในสวนของการกําหนดการ
ทํางานของโปรแกรม ( CPU จะทํางานเร็วขึ้น ) เนื่องจาก
วาโปรแกรม Flip ก็สามารถที่จะกําหนดคานี้ไดเชนกัน
จากชอง X2 แตการกําหนดนี้จะไมมีผลถาผูอานใสคําส่ัง
ใด คําส่ังหนึ่งทางดานบน  

 

 จากการทดลองโปรแกรมของผูเขียน, ผูเขียนใช
บ อ ร ด  ET-COV 34 TO 10 รว ม กั บ บ อ ร ด  ET-TEST 
10P/OUT  
 

 
รูปบอรดบอรด ET-COV 34 TO 10 

 

 
รูปบอรดบอรด ET-TEST 10P/OUT 

 
 จากรูปดานบนบอรด ET-COV 34 TO 10 จะ
ทําหนาที่เปลี่ยนจากพอรต 34 Pin ใหกลายเปนพอรต 10 

Pin ไดแก P0, P1, P2 เพื่อใหใชงานไดกับบอรด ET-
TEST 10P/OUT  
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Two Wire Interface (TWI) 
 

 Two Wire Interface คือ การสื่อสารอนุกรม
มาตรฐาน แบบ Synchronous โดยใชสายสัญญาณเพียง 
2 เสน คือ SCL(Serial Clock) และ SDA(Serial Data) 
ส่ือสารแบบ Bi-directional โดยอัตราการสงถายขอมูลสูง
สุดจะอยูที่ 400Kbit/s ที่ Standard mode รูปดานลาง
แสดงการติดตอโดยทั่วไปของบัส TWI ( I2C )  

 

การติดตั้งระบบบัส TWI 
 

 CPU จะติดตอกับสวน TWI ผานทางรีจิสเตอร 
SFRs  เหลานี้ คือ  

 SSCON : ดูตารางที่ 84 และ 79 ใน Datasheet 
 SSDAT : ดูตารางที่ 85 ใน Datasheet 
 SSCS : ดูตารางที่ 86 ใน Datasheet 
 SSADR : ดูตารางที่ 87 และ 88 ใน Datasheet 

 

รีจีสเตอร SSCON : ใชสําหรับเปดการใชงาน TWI  ,
กําหนดคา bit rate ( ตาราง 79 ) , กําหนดการทํางานเปน 
Slave mode , สงเงื่อนไข Start หรือ Stop เปนตน นอก
จากนั้นในขณะที่ CPU รีเซ็ต การทํางานในสวนของ TWI 
จะถูก Disable  

 

รีจีสเตอร SSCS : ใชสําหรับเก็บคา Status code ซึ่งมัน
จะสะทอนถึงสถานะ บนบัส TWI โดย 3 บิตแรกจะเปน 
‘0’ เสมอ สวน 5 บิตที่เหลือจะใชเก็บคา Status code ซึ่ง
มีทั้งหมด 26 สถานะ โดย Status code ที่ถูกตองจะเกิด
ขึ้นหลังจากที่บิต SI ในรีจิสเตอร SSCON นั้นถูกเซ็ตโดย 
Hardware และ คาสถานะจะยังคงคางอยูจนกวาบิต SI 
จะถูกรีเซ็ตโดย Software ( ผูอานตองเขียนโปรแกรมควบ
คุมบิต SI ) โดยตารางที่ 20 – 25 ใน Datasheet เบอร 
AT89C5132 นั้นแสดงคาสถานะตางๆ ของแตละเหตุ
การณที่จะเกิดขึ้น ( สาเหตุที่ผูเขียนใหดู Datasheet 
เบอร AT89C5132 เนื่องจากวาขอมูลใน Datasheet 
ของเบอร AT89C5131 นั้นมีไมครบถวน  ) 
 

รีจีสเตอร SSDAT : ใชสําเก็บคาขอมูล 1 ไบต ที่ใชสง
ออกไปภายนอก หรือ ใชรับขอมูล 1 ไบตจากภายนอกเขา
มา ซึ่งในขณะที่รีจิสเตอรกําลังทํากระบวนการเลื่อนขอมูล 
อยูนั้นผูอานจะไมสามารถเขาถึงรีจิสเตอรนี้ได และ ตราบ
ใดที่ Serial Interrupt Flag ( SI ) นั้นเซ็ต ‘1’ ขอมูลในรีจิต
เตอรนี้จะไมเปลี่ยนแปลง และ ทันทีที่ขอมูลกําลังเลื่อน 
ออกจากรีจิสเตอร SSDAT ขอมูลนี้จะลงสูบัสทันที  

 

รีจีสเตอร SSADR : ใชสําเก็บคาแอดเดรสประจําตัว
ของ CPU ในกรณีที่ตัวมันเปน Slave กลาวคือ ผูอาน
สามารถกําหนดคา 7- bit slave address ( 7 บิต สูงสุด ) 
ซึ่งการสงถายขอมูลบนบัส TWI ( I2C ) แสดงดังรูปดาน
ลาง คือ  

การสงถายขอมูลบนบัส TWI ที่สมบูรณ 
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ในสวนของโหมดการทํางานจะมี 4 โหมด คือ 

 

 Master Transmitter 
 Master Receiver 
 Slave Transmitter 
 Slave Receiver 

 

 โหมดการทํางานทั้ง 4 ผูเขียนจะอธิบายในราย
ละเอียดเพียงแค 2 โหมดเทานั้น คือ Master Transmitter  
และ Master Receiver โดยภายใน 2 หัวขอนี้จะอธิบาย
การทํางานดวยแผนผังภาพ ซึ่งคาตัวเลขในวงกลมจะ
เปล่ียนแปลงเมื่อแฟลก SI เซ็ตเปน ‘1’ โดย Hardware 
และ คา Status code ( คาตัวเลขในวงกลม ) จะปรากฎ
ในรีจิสเตอร SSCS ซึ่ง ณ. จุดนี้จะทําใหโปรแกรมตอบ
สนองการ Interrupt นั้นทํางาน 

 

 การทําโปรแกรมตอบสนอง Interrupt จะไม
หยุดลง อันเนื่องจากการเขาสูโหมด Suspend จนกวา 
แฟลก SI จะถูก Clear โดย Software 

 

 เมื่อเขาสูโปรแกรมตอบสนองการ Interrupt , 
คา Status code จะใชเลือกโปรแกรมการทํางานที่เหมาะ
สม ( ดูในตัวอยางประกอบ )  

 

Master Transmitter Mode  

 

 การทํางานในโหมดนี้ คือ กําหนดให CPU เปน 
Master ที่ทําหนาที่เปนตัวสงขอมูล ซึ่งผูอานจะตอง
กําหนดคาในรีจิสเตอร SSCON เปนดังนี้ คือ 

 

CR2 SSIE STA STO SI AA CR1 CR0 
Bit 

rate 
1 0 0 0 X Bit 

rete 
Bit 
rate 

 
จากตารางขางบน, บิต CR0, CR1 และ CR2 จะใช
กําหนดคา Internal bit rate ( ในกรณีที่ไมได Enable 
การทํางานในสวน External bit rate generator , บิต 

SSIE ผูอานจะตองเซ็ตเปน ‘1’ เพ่ือ Enable การทํางาน
สวนควบคุมการติดตอสื่อสารแบบ TWI ( SSLC )  
 

 

รูปแบบการสงขอมูล และ สถานะตางๆ 
 

ทันทีที่บิต STA ถูกเซ็ตผูอานจะเขาสูโหมดการทํางานของ 
Master transmitter mode ทันที โดยบัสจะถูกตรวจสอบ
วาอยูในสถานะวาง หรือ ไม ถาวางก็จะสรางสัญญาณ 
START condition ทันที จากนั้นบิตแฟลก SI ในรีจิสเตอร 
SSCON จะเซ็ตเปน ‘1’ โดย Hardware ทันที และ 
โปรแกรมกระโดดไปทําโปรแกรมตอบสนองการ Interrupt 
สงผลใหคา Status code ในรีจิสเตอร SSCS มีคา 08H 
ซึ่งคา 08H นี้จะใชเปนตัวชี้เพื่อเลือกโปรแกรมการทํางาน
ตางๆ ใน โปรแกรมตอบสนองการ Interrupt  ซึ่งในที่นี้คา
ในรีจิสเตอร SSCS คือ 08H ดังนั้น โปรแกรมยอยที่ถูก
กระทําควรจะเปนการสงคา Slave address และ คา 
Data direction bit (SLA + W) ไปใหอุปกรณ Slave ( ผู
อานควรจะดูรูปแผนผังทางดานบน ประกอบ )  

 

 เมื่ออุปกรณ Slave ไดรับขอมูลแอดเดรส และ 
บิตกําหนดทิศทางแลว Slave จะสงบิต Acknowledge – 



                       The Examples of CP-JR51USB V1.0      

 ETT CO.,LTD.                                       6                                     WWW.ETT.CO.TH  

 

ment กลับมาให CPU จากนั้นบิต SI จะถูกเซ็ตอีกครั้ง 
และ คา Status code ในรีจิสเตอร SSCS จะมีคาตางๆ 
ไดตามนี้ คือ 18H, หรือ 20H หรือ 38H ซ่ึงขึ้นอยูกับการ
ตอบกลับของอุปกรณ Slave ดูตารางที่ 48 ใน Data - 
sheet ประกอบ 

 

 เมื่อผูอานสงเงื่อนไข Start ไปแลวบิต SSIE, 
CR2, CR1, และ CR0 จะไมมีผลตอการสื่อสารบนบัส 
TWI อีก และ ในกรณีที่ผูอานสงเงื่อนไข Start เปนครั้งที่ 2 
หนวยควมคุมบัส TWI ( SSLC ) จะสลับโหมดการทํางาน
เปน Master receiver mode (  status code = 10H ) 
และ จะสงคา SLA + R ออกไป 
 
Master Receiver Mode  

 

 การทํางานในโหมด Master Receiver Mode นี้
จะมีรูปแบบการรับขอมูล และ สถานะตางๆ ดังนี้ คือ 

 
 
 
 
 

 

การสงถายขอมูล ( Transfer ) เริ่มแรกจะกําหนดการ
ทํางานเปน Master transmiter mode  เสมอ เมื่อมีเงื่อน
ไข START เกิดขึ้นโปรแกรมตอบสนองการ Interrupt จะ
โหลดคา ( SLA + R ) จากรีจิสเตอร SSDAT ออกไปให
อุปกรณ Slave และ บิต SI (Serial interrupt flag) จะเซ็ต 
ซึ่งผูอานเคลียบิตนี้กอนที่การสงขอมูลจะทํางาน 

 

 เมื่อ Slave address กับ Direction bit ถูกสง
ออกไปสมบูรณแลว อุปกรณ Slave จะสงสัญญาณ A , 
Acknowledgement   กลับออกมาใหกับ CPU เพื่อบอก
วาขอมูลไดรับครบแลว จากนั้นบิต SI (Serial interrupt 
flag) จะถูกเซ็ตอีกครั้งหนึ่ง และ คาตัวเลขในรีจิสเตอรที่
เปนไปได คือ 40H, 48H,  หรือ 38H ซึ่งตองขึ้นอยูกับ
เงื่อนไขตางๆ ( ดู Datasheet เพิ่มเติม )  

 

 ในสวนของการกําหนดอัตราความเร็วในการรับ
สงขอมูลนั้นผูอานสามารถดูไดจากตารางดานลาง แต
เนื่องจากในตารางมีคา X’tal อยู 2 คา คือ 12MHz , และ 
16 MHz เทานั้น ดังนั้น บอรด CP-JR51USB v1.0 จะหา
คาที่ CR2, CR1, CR0 = ‘0’ ได คือ 
 

25624)( ÷= MHzkHzcyBitFrequen  
                         kHz75.93= …….# 
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Examples 2:  [24XX256_W.ASM ]  โปรแกรมนี้เปนการเขียนขอมูลจํานวน 256 bytes ลงไปบนหนวยความจํา 
EEPROM ต้ังแตแอดเดรส 00H – 0FFH ดวยระบบบัส I2C ในที่นี้ผูเขียนใชชิป EEPROM เบอร 24LC256 ซ่ึงมีความจุทั้ง
หมด 32 Kbytes จากโปรแกรมดานลาง, คาที่เขียนจะเริ่มจาก 10H แลวจะเพิ่มคาขึ้นทีละ 1 ไปเลื่อยๆ ( ผูอานจะตองรัน
โปรแกรม [24xx256_2_UART.ASM]  เพ่ือดูคาที่เขียนเขาไปใน EEPROM ผานทางโปรแกรม PROCOMM 3 )  

;********************************************************************* 
; DESCRIBTION : THIS PROGRAM IS WRITE DATA TO EEPROM 
; FILE NAME   : 24XX256_W.ASM 
; COMPILER    : CROSS 32 
; SUPPORT     : AT89C5131 
; DATE        : 26 August 2004 
;********************************************************************* 
 
 CPU "8051.TBL" ; Processor declaration 
 HOF "INT8"  ; Intel 8-bit hexcode 
 INCL    "AT89C5131.SFR"  
 
;********************************************************************* 
; DEFINE BYTE SECTION 
;********************************************************************* 
TWI_DATA EQU 20H 
SLAVE_ADR EQU 21H 
ADR_H  EQU 22H 
ADR_L  EQU 23H 
B_TWI_BUSY EQU 25H ; BIT TYPE 
TWI_DATA_I EQU 26H 
STOP_BACKUP EQU 27H 
 
;********************************************************************* 
; DEFINE BIT SECTION 
;********************************************************************* 
RW  EQU 24H ; 0=WRITE, 1=READ  ; BIT TYPE 
;********************************************************************* 
 
  ORG 0000H  ; Reset vector 
START:  LJMP BEGIN 
 
;************************************************ 
;  INTERRUPT SECTION 
;************************************************ 
  ORG 0043H 
  LJMP TWI_IT 
 
;************************************************ 
  ORG 0100H 
;************************************************* 
;  INITIALIZE EEPROM 24XX256 
;*************************************************   
BEGIN:  ORL CKCON0,#00000001B ; 6 CLK PERIOD/MACHINE 
  ORL SSCON,#01000000B ; enable TWI */ 
  ANL SSCON,#01000100B ;  
  SETB EA   ; interrupt enable */ 
  ORL IEN1,#02h  ; enable TWI interrupt */ 
  CLR B_TWI_BUSY 
  MOV TWI_DATA,#10H  ; data example to send */** 
  MOV ADR_H,#00H 
  MOV ADR_L,#00H 
  MOV STOP_BACKUP,#00H 
  MOV R0,#00H 
  MOV P0,#0FH 
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LOOP_W: MOV ACC,STOP_BACKUP ; FIND STOP BIT, IF '1' JUMP 
  JB ACC.4,CONT_W 
 
  JB B_TWI_BUSY,END_IF_W ; jump if b_TWI_busy bit = '1'*/ 
  MOV ACC,SSCON 
  JB ACC.4,END_IF_W ; jump if acc.4 bit = '1' "STOP FLAG" 
      ; usually not jump*/ 
  SETB B_TWI_BUSY  ; flag busy =1 , now, I'm not Empty.*/ 
  MOV SLAVE_ADR,#10100000B; slave adresse example  
  CLR RW   ; 0= WRITE 
  MOV SSDAT,#00h  ; clear buffer before sending data 
  ORL SSCON,#00100000B ; TWI start sending */ after that SI  
      ; bit is set '1' 
      ; and  the status code in SSCS will be 
      ; 08h. 
 
  JMP LOOP_W 
; ************************************************ 
CONT_W: MOV STOP_BACKUP,#00H 
  INC ADR_L 
  INC TWI_DATA 
  INC R0 
 
  CJNE R0,#00H,LOOP_W ; 0 - 255h 
  MOV P0,#55H 
  SJMP $ 
END_IF_W: JMP LOOP_W 
 
; ************************************************ 
;  INTERRUPT SERVICE ROUTINE 
; ************************************************ 
TWI_IT:  MOV R7,SSCS 
 
; ************* TWI status tasking *************** 
    
CASE_00: CJNE R7,#00h,CASE_08 ; A start condition has been sent  
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  CLR B_TWI_BUSY  ; TWI is free  
  ORL SSCON,#10H  ; SEND STOP 
  LJMP end_switch 
 
CASE_08: CJNE R7,#08h,CASE_10 ; A start condition has been sent 
      ; SLR+R/W are transmitted, ACK bit 
      ; received  
  ANL SSCON,#~20h  ; clear start condition  
 
;   send slave adress and read/write bit  
 
  MOV ACC,slave_adr 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  LJMP end_switch 
 
CASE_10: CJNE R7,#10h,CASE_18 ; A repeated start condition has been  
      ; sent 
      ; SLR+R/W are transmitted, ACK bit 
      ; received 
  ANL SSCON,#~20h  ; clear start condition  
;  send slave adress and read/write bit  
  MOV ACC,slave_adr 
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  ;========= 
  SETB RW 
  ;========= 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  JMP end_switch 
 
CASE_18: CJNE R7,#18h,case_20 ; SLR+W was transmitted, ACK bit  
      ; received 
 
  ANL SSCON,#11110111B ; clear SI  
  MOV SSDAT,ADR_H 
CHECK_FIR: MOV ACC,SSCON 
  JNB ACC.3,CHECK_FIR ; JUMP IF SI = '0' 
 
  ANL SSCON,#11110111B ; clear SI  
  MOV SSDAT,ADR_L 
CHECK_SEC: MOV ACC,SSCON 
  JNB ACC.3,CHECK_SEC ; JUMP IF ACC.3 = '0' 
 
  ANL SSCON,#11110111B ; clear SI  
  MOV SSDAT,TWI_data ; Transmit data byte, ACK bit received 
  JMP end_switch 
 
CASE_20: CJNE R7,#20h,case_28 ; SLR+W was transmitted, NOT ACK bit 
      ; received 
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_28: CJNE R7,#28h,case_30 ; DATA was transmitted, ACK bit  
      ; received 
  ;ANL SSCON,#11110111B ; clear SI  
  ORL SSCON,#10h  ; send STOP  
  MOV STOP_BACKUP,SSCON ; BACKUP 
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_30: CJNE R7,#30h,case_38 ; DATA was transmitted, NOT ACK bit 
      ; received  
  ORL SSCON,#10h  ; Transmit STOP  
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_38: CJNE R7,#38h,case_40 ; Arbitration lost in SLA+W or DATA.  
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_40: CJNE R7,#40h,case_58 ; As soon as, the DATA will move to  
      ; SSDAT SFR. 
  ANL SSCON,#11110111B ; clear SI 
S40:  MOV ACC,SSCON 
  JNB ACC.3,S40  ; JUMP IF SI = '0' 
  MOV TWI_DATA_I,SSDAT ; Master will send ACK or NACK to slave
 
  ;================================ 
  ;ORL SSCON,#00000100B ; set AA  */ SENT ACK 
  ANL SSCON,#11111011B ; CLR AA  */ SENT NACK ( DEFAULT USED )
  ;================================ 
  LJMP end_switch 
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CASE_58: CJNE R7,#58h,case_5X  
  ORL SSCON,#00010000B ; send STOP  
  MOV STOP_BACKUP,SSCON ; BACKUP 
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_5X: 
end_switch: ANL SSCON,#11110111B ; clear SI flag  
  RETI 
 
; ************************************************ 
;  DELAY    
; ************************************************ 
DELAY:  MOV R7,#9 
D1:  MOV R6,#5 
D2:  NOP 
  NOP  
  DJNZ R6,D2 
  DJNZ R7,D1 
  RET 
 
; ************************************************ 
;  DELAY  
; ************************************************ 
DELAYS:  MOV R7,#25 
D1S:  MOV R6,#20 
D2S:  NOP 
  NOP  
  DJNZ R6,D2S 
  DJNZ R7,D1S 
  RET 
  END 
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คําอธิบาย 

 

 จากที่ผูอานไดศึกษาทฤษฎีในตอนตนมาแลว, 
ในโปรแกรมทางดานบนเมื่อมองในภาพกวางๆ  แลวจะ
เห็นวาตั้งแต BEGIN ลงมาจนถึง END_IF นั้น จะเปน
สวน BODY ของโปรแกรม และ ตอจากนี้ลงไปจะเปน
โปรแกรมยอย ซึ่งจะทํางานเมื่อมีการ Interrupt เกิดขึ้น   
และ เนื่องจากโปรแกรมนี้เปนการเขียนขอมูลเพียงอยาง
เดียว ดังนั้น CASE_XX ใดๆ ในโปรแกรมยอยที่จําเปน
ตองใชงานคือ CASE_08, CASE_18, CASE_28 เทานั้น  
ซ่ึงอธิบายไดดังนี้ คือ เริ่มแรกผูอานตองทราบรูปแบบ 
หรือ Protocol ของการสงขอมูลบนระบบบัส I2C ในแบบ
มาตรฐานกอน ซึ่งเปนมาตรฐานของบริษัท Philips จาก
นั้นนํารูปแบบการสง TWI ของชิป AT89C5131 จัดให
สอดคลองกับมาตรฐาน I2C ของ Philips , สําหรับตัว
อยางทางดานบนมีรูปแบบการสงเปนดังนี้ คือ  
 

 
                     แสดงการเขียนขอมูล 1 byte ( 24LC256 ) 

 
 

ซึ่งผูอานจะเห็นวาโปรแกรมยอย CASE_08 จะทําหนาที่
สง Control byte ของ EEPROM , CASE_18 จะทําหนา
ที่สงคาตําแหนง Address ของ EEPROM จํานวน 2ไบต 
และ สุดทาย CASE_28 จะสง STOP condition.  
 

 
 
 
 
 
 
 
 
 

 
 
 
 

S
Control Byte ของ EEP

101 00 00 0 A aax aa aa a A

ddd dd dd d A P

คาแอดเดรสไบทสูง

คาขอมูลที่จะเขียน

สภ
าวะ

เริ่ม
ตน

สภ
าวะ

สิ้น
สุด

บิต
 รับ

รู

บิต
 รับ

รู

บิต
 รับ

รู

คาแอดเดรสไบทตํา

aaa aa aa a A

บิต
 รับ

รู

บิต
 R/

W

คําเตือน ( CAUTION ) :  
ผูอานตอนระลึกไวเสมอวา การตอบสนองอินเตอรรัพต
ของ CPU จะไมเกิดขึ้นในขณะที่ CPU กําลังทํา
โปรแกรมตอบสนองอินเตอรรัพตของสัญญาณรองขอ
อินเตอรรัพตที่มีระดับความสําคัญเทากันอยู 

Tip : เนื้อหาเกี่ยวกับ I2C ผูอานสามารถดูไดจาก
หนังสือ “ รูจักและเขาใจ I2C BUS “ ของบริษัท ETT 
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Examples 3:  [ 24LC256_R_LED.ASM]  โปรแกรมนี้เปนการอานขอมูลจาก EEPROM จํานวน 1 ไบต แลวนํา
ไปแสดงผลบนพอรต 0 ซึ่งผูอานควรตอ LED ไวที่พอรตนี้ ( common A ผาน R = 470 โอหม )  

;********************************************************************* 
; DESCRIBTION : THIS PROGRAM IS READ DATA TO EEPROM 
; FILE NAME   : 24LC256_R_LED.ASM 
; COMPILER    : CROSS 32 
; SUPPORT     : AT89C5131 
; DATE        : 26 September 2004 
; DESCRIBTION : DISPLAY THE DATA IN EEPROM, ADDRESS 00H - 0FFH 
;********************************************************************* 
 
 CPU "8051.TBL" ; Processor declaration 
 HOF "INT8"  ; Intel 8-bit hexcode 
 INCL    "AT89C5131.SFR"  
 
;********************************************************************* 
; DEFINE SECTION 
;********************************************************************* 
TWI_DATA EQU 20H 
SLAVE_ADR EQU 21H 
ADR_H  EQU 22H 
ADR_L  EQU 23H 
RW  EQU 24H ; 0=WRITE, 1=READ  ; BIT TYPE 
B_TWI_BUSY EQU 25H ; BIT TYPE 
TWI_DATA_I EQU 26H 
STOP_BACKUP EQU 27H 
HEX2IN  EQU 30H 
ASC_L  EQU 31H 
ASC_H  EQU 32H 
IE  EQU    0A8H 
;********************************************************************* 
 
  ORG 0000H  ; Reset vector 
  LJMP BEGIN 
 
;************************************************ 
;  INTERRUPT SECTION 
;************************************************ 
  ORG 0043H 
  LJMP TWI_IT 
  
;************************************************ 
  ORG 0100H 
   
BEGIN:  MOV     SP,#256-32  ;define stack = 32 byte 
  ORL CKCON0,#00000001B ; 6 CLK PERIOD/MACHINE 
 
;*************************************************   
;  INITIALIZE EEPROM 24XX256 
;*************************************************   
  ORL SSCON,#40h  ; enable TWI */ 
  SETB EA   ; interrupt enable */ 
  ORL IEN1,#02h  ; enable TWI interrupt */ 
  CLR B_TWI_BUSY 
  MOV TWI_DATA,#00H  ; data example to send 
  MOV STOP_BACKUP,#00H 
  MOV ADR_H,#00h 
  MOV ADR_L,#00h 
  MOV R0,#00H 
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;================================================ 
;  READ EEPROM 24XX256 
;================================================ 
LOOP:  MOV ACC,STOP_BACKUP   
  JB ACC.4,CONT  ; FIND STOP BIT, IF '1' JUMP 
 
  JB B_TWI_BUSY,END_IF ; jump if b_TWI_busy bit = '1'*/ 
  MOV ACC,SSCON 
  JB ACC.4,END_IF  ; jump if acc.4 bit = '1' "STOP BIT" 
      ; usually not jump*/ 
  SETB B_TWI_BUSY  ; flag busy =1 , now, I'm not Empty.*/ 
  MOV SLAVE_ADR,#10100000B; slave adresse example  
  CLR RW   ; 0=write  
  MOV SSDAT,#00h  ; clear buffer before sending data 
 
  ;============= 
START:  ORL SSCON,#20h  ; TWI start sending */ after that SI bit 
      ; is set '1' 
          ; and the status code in SSCS will be 08h.
  JMP LOOP 
;================================================ 
;  DISPLAY TO LED 
;================================================ 
CONT:  MOV STOP_BACKUP,#00H 
  MOV P0,TWI_DATA_I 
  sjmp $ 
 
END_IF: LJMP LOOP 
 
; ************************************************ 
;  INTERRUPT SERVICE ROUTINE 
; ************************************************ 
TWI_IT: MOV R7,SSCS 
 
;============== TWI status tasking  ============ 
    
CASE_00: CJNE R7,#00h,CASE_08 ; A start condition has been sent  
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  CLR B_TWI_BUSY  ; TWI is free  
  ORL SSCON,#10H  ; SEND STOP 
  LJMP end_switch 
 
CASE_08: CJNE R7,#08h,CASE_10 ; A start condition has been sent 
      ; SLR+R/W are transmitted, ACK bit  
      ; received   
  ANL SSCON,#~20h  ; clear start condition  
 
;   send slave adress and read/write bit  
 
  MOV ACC,slave_adr 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  LJMP end_switch 
   
CASE_10: CJNE R7,#10h,CASE_18 ; A repeated start condition has been  
      ; sent 
      ; SLR+R/W are transmitted, ACK bit  
      ; received   
  ANL SSCON,#~20h  ; clear start condition  
;  send slave adress and read/write bit  
  MOV ACC,slave_adr 
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  ;========= 
  SETB RW 
  ;========= 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  JMP end_switch 
 
CASE_18: CJNE R7,#18h,case_20 ; SLR+W was transmitted, ACK bit  
      ; received 
   
FIRST_D: MOV SSDAT,ADR_H 
  ANL SSCON,#11110111B ; clear SI 
S18:  MOV ACC,SSCON 
  JNB ACC.3,S18  ; JUMP IF SI = '0' 
  
  MOV SSDAT,ADR_L 
  LJMP end_switch 
 
CASE_20: CJNE R7,#20h,case_28 ; SLR+W was transmitted, NOT ACK bit  
      ; received 
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_28: CJNE R7,#28h,case_30 ; DATA was transmitted, ACK bit received 
  ORL SSCON,#20h  ; send start  
  JMP end_switch 
 
CASE_30: CJNE R7,#30h,case_38 ; DATA was transmitted, NOT ACK bit  
      ; received 
  ORL SSCON,#10h  ; Transmit STOP  
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_38: CJNE R7,#38h,case_40 ; Arbitration lost in SLA+W or DATA.  
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_40: CJNE R7,#40h,case_58 ; As soon as, the DATA will move to  
      ; SSDAT SFR. 
  ANL SSCON,#11110111B ; clear SI 
S40:  MOV ACC,SSCON 
  JNB ACC.3,S40  ; JUMP IF SI = '0' 
  MOV TWI_DATA_I,SSDAT ; Master will send ACK or NACK to slave 
 
  ;================================ 
  ;ORL SSCON,#00000100B ; set AA  */ SENT ACK 
  ANL SSCON,#11111011B ; CLR AA  */ SENT NACK  ( DEFAULT USED )
  ;================================ 
  LJMP end_switch 
 
CASE_58: CJNE R7,#58h,case_5X  
  ORL SSCON,#00010000B ; send STOP  
  MOV STOP_BACKUP,SSCON ; BACKUP 
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_5X: 
end_switch: ANL SSCON,#11110111B ; clear SI flag  
  RETI 
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; ************************************************ 
;  DELAY    
; ************************************************ 
DELAY:  MOV R7,#9 
D1:  MOV R6,#5 
D2:  NOP 
  NOP  
  DJNZ R6,D2 
  DJNZ R7,D1 
  RET 
 
; ************************************************ 
;  DELAY   
; ************************************************ 
DELAYS:  MOV R7,#25 
D1S:  MOV R6,#20 
D2S:  NOP 
  NOP  
  DJNZ R6,D2S 
  DJNZ R7,D1S 
  RET 
 
DELAY_1S: MOV R7,#150 
D1M:  MOV R6,#50 
D2M:  MOV R5,#50 
D3M:  NOP 
  NOP 
  DJNZ R5,D3M 
  DJNZ R6,D2M 
  DJNZ R7,D1M 
  RET 
  END 
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คําอธิบาย 
 

 จากที่ผูอานไดศึกษาตัวอยางการเขียนขอมูลให
กับ EEPROM ไปแลวกอนหนานี้ ซึ่งจะเห็นวาโปรแกรม
บริการ Interrupt ที่ถูกใชงานจะมีแค CASE_08, 
CASE_18, CASE_28 เทานั้น  สวนโปรแกรมการอาน 
EEPROM นี้จะใช CASE_08, CASE_18, CASE_28, 
CASE_10, CASE_40 และ CASE_58 ( สาเหตุที่ไมทํา 
CASE_50 เนื่องจากผูเขียนอานทีละ 1 byte จึงตอบกลับ
ดวยสัญญาณ  A  ), ในการรับขอมูล โดยเริ่มแรกตอง
กําหนดใหเปนการเขียนขอมูลไปให EEPROM กอน ซ่ึง
รูปแบบการอานขอมูลในแบบมาตรฐาน แสดงดังภาพ
ดานลาง คือ 

 

 
 

 
 
 สิ่งที่ผูอานตองระวัง คือ  CASE_18 กับ 
CASE_28 นั้นจะไมเหมือนกันกับ การเขียนขอมูล เนื่อง
จากวา  CASE_18 ในโปรแกรมการอานขอมูล จะตองสง
คา Address ของขอมูลบนตัว EEPROM เทานั้น ในขณะ
ที่โปรแกรมการเขียนจะตองใสขอมูล 1 ไบตลงไปในสวนนี้
ดวย , ในสวนของ CASE_28 ในโปรแกรมการอานนั้นจะ
ไมสงสถานะ STOP แตจะสง START แทนเพื่อจะกระโดด
ไปทํา CASE_10 เพื่อสง SLA + R จากนั้นจะกระโดดไป

ทํา CASE_40 ของรูปที่ 50 ตอไป ( ดูรูปที่ 49 Master 
Transmitter Mode ใน Datasheet ประกอบ )  

 

 คาที่ไดจากการอานจะอยูใน TWI_DATA_I ซึ่ง
อยูใน CASE_40 และ จะสงผานพอรต P0 ซึ่งตรงนี้ผูอาน
จะตองตอ Hardware รองรับไวดวย โดยในที่นี้ผูเขียนใช
ชุด ET-TEST 10P/OUT  ในการทดสอบโปรแกรมนี้ 
  
  
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 

 
 

 

S
Control Byte ของ EEP

101 00 00 0 A aax aa aa a A
คาแอดเดรสไบทสูง

สภ
าวะ

เริ่ม
ตน

บิต
 รับ

รู

บิต
 รับ

รู

คาแอดเดรสไบทตํา

aaa aa aa a A

บิต
 รับ

รู

บิต
 R/

W

S
Control Byte ของ EEP

101 00 00 1 A ddd dd dd d A P
ไบทขอมูลที่อานได

สภ
าวะ

เริ่ม
ตน

สภ
าวะ

สิ้น
สุด

บิต
 รับ

รู

บิต
 รับ

รู

บิต
 R/

W คาแอดเดรสเพิ่มขึ้น 1
ในทุกๆไบทของขอมูล

แสดงรูปแบบการรับขอมูลของ EEPROM 

คําเตือน ( CAUTION ) :  
ผูอานตอนระลึกไวเสมอวา การตอบสนองอินเตอรรัพต
ของ CPU จะไมเกิดขึ้นในขณะที่ CPU กําลังทํา
โปรแกรมตอบสนองอินเตอรรัพตของสัญญาณรองขอ
อินเตอรรัพตที่มีระดับความสําคัญเทากันอยู 
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Examples 4:  [24xx256_2_UART.ASM]  โปรแกรมนี้เปนการอานขอมูลจากบัส TWI แลวสงขอมูลผานพอรต 
UART ดวยอัตรา Baud rate = 115200bps ( กอนรันโปรแกรมนี้ผูอานควรจะรันโปรแกรม 24XX256_W.ASM มากอน 
และ จะตองเปดโปรแกรม Procomm 3 ไวดวย )  

;********************************************************************* 
; DESCRIBTION : THIS PROGRAM IS READ DATA TO EEPROM 
; FILE NAME   : 24xx256_2_UART.ASM 
; COMPILER    : CROSS 32 
; SUPPORT     : AT89C5131 
; DATE        : 25 August 2004 
; DESCRIBTION : DISPLAY THE DATA IN EEPROM, ADDRESS 00H - 0FFH 
;********************************************************************* 
 
 CPU "8051.TBL" ; Processor declaration 
 HOF "INT8"  ; Intel 8-bit hexcode 
 INCL    "AT89C5131.SFR"  
 
;********************************************************************* 
; DEFINE SECTION 
;********************************************************************* 
TWI_DATA EQU 20H 
SLAVE_ADR EQU 21H 
ADR_H  EQU 22H 
ADR_L  EQU 23H 
RW  EQU 24H ; 0=WRITE, 1=READ  ; BIT TYPE 
B_TWI_BUSY EQU 25H ; BIT TYPE 
TWI_DATA_I EQU 26H 
STOP_BACKUP EQU 27H 
HEX2IN  EQU 30H 
ASC_L  EQU 31H 
ASC_H  EQU 32H 
IE  EQU    0A8H 
;********************************************************************* 
 
  ORG 0000H  ; Reset vector 
  LJMP BEGIN 
 
;************************************************ 
;  INTERRUPT SECTION 
;************************************************ 
  ORG 0043H 
  LJMP TWI_IT 
  
;************************************************ 
  ORG 0100H 
   
BEGIN:  MOV     SP,#256-32  ;define stack = 32 byte 
  ORL CKCON0,#00000001B ; 6 CLK PERIOD/MACHINE 
;************************************************* 
;  UART 115200bps 
;************************************************* 
INIT_SER: ORL CKCON0,#00000001B ; 6 CLK PERIOD/MACHINE 
  ORL PCON,#11000000B  ; ENABLE THE FRAMING BIT ERROR 
DETECTION, DOUBLE BAUD RATE 
      ; AND CHECK FE BIT OF SCON SFR 
  ORL BDRCON,#00001110B ; SPD=1,RBCK =1, TBCK =1 
  MOV SCON,#01010000B  ; uart in mode 1 (8 bit), REN=1  
  MOV BRL,#243  ; U CAN SEE THIS VALUE FROM PAGE 71 OF 
DATASHEET 
  ORL BDRCON,#00010000B ; BRR = 1 , START BAUD RATE RUN 
  CLR     ES 
  CLR     EA 
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  ;================== 
  ;  CLEAR DISPLAY 
  ;================== 
  MOV A,#0CH   ; "CLEAR DISPLAY" 
  LCALL TX_BYTE 
 
  ;================== 
  ;  MASSAGE 
  ;================== 
  MOV DPTR,#SHOW1 
  LCALL TRANSMIT 
 
;*************************************************   
;  INITIALIZE EEPROM 24XX256 
;*************************************************   
  ORL SSCON,#40h  ; enable TWI */ 
  SETB EA   ; interrupt enable */ 
  ORL IEN1,#02h  ; enable TWI interrupt */ 
  CLR B_TWI_BUSY 
  MOV TWI_DATA,#00H  ; data example to send 
  MOV STOP_BACKUP,#00H 
  MOV ADR_H,#00h 
  MOV ADR_L,#00h 
  MOV R0,#00H 
 
;================================================ 
;  READ EEPROM 24XX256 
;================================================ 
LOOP_R: MOV ACC,STOP_BACKUP   
  JB ACC.4,CONT_R  ; FIND STOP BIT, IF '1' JUMP 
 
  JB B_TWI_BUSY,END_IF_R ; jump if b_TWI_busy bit = '1'*/ 
  MOV ACC,SSCON 
  JB ACC.4,END_IF_R ; jump if acc.4 bit = '1' "STOP BIT" 
      ; usually not jump*/ 
  SETB B_TWI_BUSY  ; flag busy =1 , now, I'm not Empty.*/ 
  MOV SLAVE_ADR,#10100000B; slave adresse example  
  CLR RW   ; 0=write  
  MOV SSDAT,#00h  ; clear buffer before sending data 
 
  ;============= 
START_R: ORL SSCON,#20h  ; TWI start sending */ after that SI bit 
      ; is set '1' 
      ; and  the status code in SSCS will be  
      ; 08h. 
  JMP LOOP_R 
;================================================ 
;  DISPLAY TO LED 
;================================================ 
CONT_R: MOV STOP_BACKUP,#00H 
 
  MOV HEX2IN,TWI_DATA_I 
  LCALL DELAYS   ; JUST HAVE 
  LCALL HEX2ASC2  ; OUTPUT STAY IN "ASC_L","ASC_H" 
 
  MOV A,ASC_H 
  LCALL   TX_BYTE 
 
  MOV A,ASC_L 
  LCALL TX_BYTE 
   
  MOV A,#48H   ; "H" 
  LCALL TX_BYTE 
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  MOV A,#20H   ; "Space" 
  LCALL TX_BYTE 
 
  INC ADR_L 
  INC R0 
 
  CJNE R0,#00H,LOOP_R  ; amount = 256, rang = 0 - 255 
  sjmp $ 
 
END_IF_R: LJMP LOOP_R 
 
; ************************************************ 
;  INTERRUPT SERVICE ROUTINE 
; ************************************************ 
TWI_IT: MOV R7,SSCS 
 
;============== TWI status tasking  ============ 
    
CASE_00: CJNE R7,#00h,CASE_08 ; A start condition has been sent  
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  CLR B_TWI_BUSY  ; TWI is free  
  ORL SSCON,#10H  ; SEND STOP 
  LJMP end_switch 
 
CASE_08: CJNE R7,#08h,CASE_10 ; A start condition has been sent 
      ; SLR+R/W are transmitted, ACK bit  
      ; received  
  ANL SSCON,#~20h  ; clear start condition  
 
;   send slave adress and read/write bit  
 
  MOV ACC,slave_adr 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  LJMP end_switch 
   
CASE_10: CJNE R7,#10h,CASE_18 ; A repeated start condition has been  
      ; sent 
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  ANL SSCON,#~20h  ; clear start condition  
 
;  send slave adress and read/write bit  
 
  MOV ACC,slave_adr 
  ;========= 
  SETB RW 
  ;========= 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  JMP end_switch 
CASE_18: CJNE R7,#18h,case_20 ; SLR+W was transmitted, ACK bit   
      ; received  
   
FIRST_D: MOV SSDAT,ADR_H 
  ANL SSCON,#11110111B ; clear SI 
S18:  MOV ACC,SSCON 
  JNB ACC.3,S18  ; JUMP IF SI = '0' 
  
  MOV SSDAT,ADR_L 
  LJMP end_switch 



                       The Examples of CP-JR51USB V1.0      

 ETT CO.,LTD.                                       20                                     WWW.ETT.CO.TH  

 

 
 

 

CASE_20: CJNE R7,#20h,case_28 ; SLR+W was transmitted, NOT ACK bit  
      ; received 
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_28: CJNE R7,#28h,case_30 ; DATA was transmitted, ACK bit received 
  ORL SSCON,#20h  ; send start  
  JMP end_switch 
 
CASE_30: CJNE R7,#30h,case_38 ; DATA was transmitted, NOT ACK bit  
      ; received 
  ORL SSCON,#10h  ; Transmit STOP  
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_38: CJNE R7,#38h,case_40 ; Arbitration lost in SLA+W or DATA.  
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_40: CJNE R7,#40h,case_58 ; As soon as, the DATA will move to  
      ; SSDAT SFR. 
  ANL SSCON,#11110111B ; clear SI 
S40:  MOV ACC,SSCON 
  JNB ACC.3,S40  ; JUMP IF SI = '0' 
  MOV TWI_DATA_I,SSDAT ; Master will send ACK or NACK to slave 
 
  ;================================ 
  ;ORL SSCON,#00000100B ; set AA  */ SENT ACK 
  ANL SSCON,#11111011B ; CLR AA  */ SENT NACK  ( DEFAULT USED )
  ;================================ 
  LJMP end_switch 
 
CASE_58: CJNE R7,#58h,case_5X  
  ORL SSCON,#00010000B ; send STOP  
  MOV STOP_BACKUP,SSCON ; BACKUP 
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_5X: 
end_switch: ANL SSCON,#11110111B ; clear SI flag  
  RETI 
 
;****************************************************** 
;*                Send 1-Byte to SERIAL               * 
;*                Input   : ACC                       * 
;*                Output  : Serial port               * 
;****************************************************** 
 
TX_BYTE:    ;LCALL DELAY   ; JUST HAVE 
            CLR    TI 
            MOV    SBUF,A 
            JNB    TI,$ 
            CLR    TI 
            RET 
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TX_CHAR:  MOV SBUF,A   ; Send Data to SBUF 
   JNB TI,$   ; Wait until TX already (TI=1) 
   CLR TI   ; Clear TI 
   AJMP TX_LOOP  ; Jump to TX_LOOP 
 
;****************************************************** 
;  CONVERT HEX 1 DIGIT TO ASCII CODE 
;  INPUT : A 
;  OUTPUT : A 
;****************************************************** 
HEX2ASC1: PUSH ACC 
  CLR C 
  SUBB A,#0AH 
  POP ACC 
  JC L_CON 
  ADD A,#7 
L_CON:  ADD A,#30H 
  RET 
 
;****************************************************** 
;  CONVERT HEX 2 DIGIT TO ASCII CODE 
;  INPUT : HEX2IN 
;  OUTPUT : ASC_L 
;  OUTPUT : ASC_H 
;****************************************************** 
HEX2ASC2: MOV A,HEX2IN 
  ANL A,#0FH 
  LCALL HEX2ASC1 
  MOV ASC_L,A 
  MOV A,HEX2IN 
  SWAP A 
  ANL A,#0FH 
  LCALL HEX2ASC1 
  MOV ASC_H,A 
  RET 
 
;-------------------------------------------------------------------------------
;-------------------------------------------------------------------------------
;-------------------------------------------------------------------------------
SHOW1:  DFB "TEST 24XX256 RANGE 00H - 0FFH",00AH,00DH,00AH,00DH,0FFH 
    
;-------------------------------------------------------------------------------
SHOW_ENTER:  DFB "ENTER",0FFH 
 
;-------------------------------------------------------------------------------
ENTER:   DFB 0AH,0DH,0FFH 
 
;-------------------------------------------------------------------------------
; ************************************************ 
;  DELAY   100us 
; ************************************************ 
DELAY:  MOV R7,#9 
D1:  MOV R6,#5 
D2:  NOP 
  NOP  
  DJNZ R6,D2 
  DJNZ R7,D1 
  RET 



                       The Examples of CP-JR51USB V1.0      

 ETT CO.,LTD.                                       22                                     WWW.ETT.CO.TH  

 
 
 
คําอธิบาย 
 

 โปรแกรมนี้จะเหมือนกันกับโปรแกรมที่ผานมา, 
เพียงแตวาโปรแกรม 24xx256_2_UART.ASM นี้นั้นจะ
สงขอมูลผานพอรตการสื่อสารอนุกรม UART ดวยอัตรา 
Baud rate = 115200 ซ่ึงหมายความวาผูอานจะตองเปด
โปรแกรม Procomm ไวกอน และ จะตองกําหนดคา 
Baud rate ของโปรแกรมนี้ใหตรงกันดวย, ซึ่งวิธีการติดตั้ง 
และ วิธีการใชงานโปรแกรม Procomm นั้นผูอานสามารถ
อานไดจากไฟลใน CD-ROM  และ รายละเอียดเกี่ยวกับ
การใชงาน UART ผูอานสามารถศึกษาไดจากตัวอยาง
การใชงานพอรต UART ไดโดยตรง  
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

; ************************************************ 
;  DELAY  1ms  
; ************************************************ 
DELAYS:  MOV R7,#25 
D1S:  MOV R6,#20 
D2S:  NOP 
  NOP  
  DJNZ R6,D2S 
  DJNZ R7,D1S 
  RET 
 
DELAY_1S: MOV R7,#150 
D1M:  MOV R6,#50 
D2M:  MOV R5,#50 
D3M:  NOP 
  NOP 
  DJNZ R5,D3M 
  DJNZ R6,D2M 
  DJNZ R7,D1M 
  RET 
  END 
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Examples 5:  [DS1307_RW.ASM]  โปรแกรมนี้เปนการใชงานชิป DS1307 โดยภายในโปรแกรมจะมี 2 สวน คือ 
สวนการเขียนขอมูลซึ่งจะเปนการกําหนดใหหลักวินาทีเริ่มทํางานที่ 00 และ สวนการอานขอมูลจากชิป DS1307 ซึ่งจะอาน
คาวินาทีออกไปแสดงที่ พอรต P0 ( ผูอานจะตองตอ LED ที่พอรต P0 ดวย common A ผาน R = 470 โอหม ) 
 

;********************************************************************* 
; DESCRIBTION : This program is showed second part on port P0. 
; FILE NAME   : DS1307_RW.ASM 
; COMPILER    : CROSS 32 
; SUPPORT     : AT89C5131 
; DATE        : 26 August 2004 
;********************************************************************* 
 
 CPU "8051.TBL" ; Processor declaration 
 HOF "INT8"  ; Intel 8-bit hexcode 
 INCL    "AT89C5131.SFR"  
 
;********************************************************************* 
; DEFINE BYTE SECTION 
;********************************************************************* 
; 
SLAVE_ADR EQU 21H 
ADR_H  EQU 22H 
ADR_L  EQU 23H 
TWI_DATA EQU 24H 
TWI_DATA_I EQU 26H 
STOP_BACKUP EQU 27H 
SEC  EQU 40H 
SEC_R  EQU 41H 
DIRECTION EQU 33H ; 01H = WRITING, 02H = READING 
;********************************************************************* 
; DEFINE BIT SECTION 
;********************************************************************* 
RW  EQU 00H ; 0=WRITE, 1=READ  ; BIT TYPE 
B_TWI_BUSY EQU 25H ; BIT TYPE 
;********************************************************************* 
 
  ORG 0000H  ; Reset vector 
START:  LJMP BEGIN_W 
 
;************************************************ 
;  INTERRUPT SECTION 
;************************************************ 
  ORG 0043H 
  LJMP TWI_IT 
 
;************************************************ 
  ORG 0100H 
;*************************************************   
;  INITIALIZE DS 1307 
;*************************************************   
BEGIN_W: ORL CKCON0,#00000001B ; 6 CLK PERIOD/MACHINE 
  ORL SSCON,#01000000B ; enable TWI */ 
  ANL SSCON,#01000100B ;  
  SETB EA   ; interrupt enable */ 
  ORL IEN1,#02h  ; enable TWI interrupt */ 
  CLR B_TWI_BUSY 
  MOV ADR_L,#00H 
  MOV SEC,#00H 
  MOV STOP_BACKUP,#00H 
  MOV DIRECTION,#01H 
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  ;MOV R0,#00H 
  MOV P1,#0FH 
 
LOOP_W: MOV ACC,STOP_BACKUP ; FIND STOP BIT, IF '1' JUMP 
  JB ACC.4,CONT_W 
 
  JB B_TWI_BUSY,END_IF_W ; jump if b_TWI_busy bit = '1'*/ 
 
  MOV ACC,SSCON 
  JB ACC.4,END_IF_W ; jump if acc.4 bit = '1' "STOP FLAG" 
      ; usually not jump*/ 
  SETB B_TWI_BUSY  ; flag busy =1 , now, I'm not Empty.*/ 
  MOV SLAVE_ADR,#11010000B; slave adresse example  
  CLR RW   ; 0= WRITE 
  MOV SSDAT,#00h  ; clear buffer before sending data 
  ORL SSCON,#00100000B ; TWI start sending */ after that SI bit 
      ; is set '1' 
     ; and  the status code in SSCS will be 08h. 
  JMP LOOP_W 
; ************************************************ 
CONT_W: MOV P1,#55H 
  LJMP BEGIN_R 
END_IF_W: JMP LOOP_W 
 
;*************************************************   
;  INITIALIZE DS1307 READ 
;************************************************* 
BEGIN_R:  
;*************************************************   
;  INITIALIZE DS1307 
;*************************************************   
  ORL SSCON,#40h   ; enable TWI */ 
  SETB EA    ; interrupt enable */ 
  ORL IEN1,#02h   ; enable TWI interrupt */ 
  CLR B_TWI_BUSY 
  MOV TWI_DATA,#00H   ; data example to send 
  MOV DIRECTION,#02H 
  MOV STOP_BACKUP,#00H 
  MOV ADR_L,#00h 
  MOV P2,#03H 
 
;================================================ 
;  READ DS1307 
;================================================ 
LOOP:  MOV ACC,STOP_BACKUP   
  JB ACC.4,CONT  ; FIND STOP BIT, IF '1' JUMP 
 
  JB B_TWI_BUSY,END_IF ; jump if b_TWI_busy bit = '1'*/ 
 
  MOV ACC,SSCON 
  JB ACC.4,END_IF  ; jump if acc.4 bit = '1' "STOP BIT" 
      ; usually not jump*/ 
  SETB B_TWI_BUSY  ; flag busy =1 , now, I'm not Empty.*/ 
  MOV SLAVE_ADR,#11010000B; slave adresse example  
  CLR RW   ; 0=write  
  MOV SSDAT,#00h  ; clear buffer before sending data 
 
  ;============= 
  ORL SSCON,#20h  ; TWI start sending */ after that SI bit 
      ; is set '1' 
     ; and  the status code in SSCS will be 08h. 
 
  JMP LOOP 
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;================================================ 
;  DISPLAY TO LED 
;================================================ 
CONT:  MOV STOP_BACKUP,#00H 
  MOV P0,SEC_R 
  LCALL DELAYS  
  MOV P2,#18H 
  sjmp loop 
 
END_IF:   
  LJMP LOOP 
 
; ************************************************ 
;  INTERRUPT SERVICE ROUTINE 
; ************************************************ 
TWI_IT: MOV R7,SSCS 
 
; ************* TWI status tasking *************** 
    
CASE_00: CJNE R7,#00h,CASE_08 ; A start condition has been sent  
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  CLR B_TWI_BUSY  ; TWI is free  
  ORL SSCON,#10H  ; SEND STOP 
 
  LJMP end_switch 
 
CASE_08: CJNE R7,#08h,CASE_10 ; A start condition has been sent 
      ; SLR+R/W are transmitted, ACK bit  
      ; received   
  ANL SSCON,#~20h  ; clear start condition  
 
;   send slave adress and read/write bit  
 
  MOV ACC,slave_adr 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
 
  LJMP end_switch 
   
CASE_10: CJNE R7,#10h,CASE_18 ; A repeated start condition has been  
      ; sent 
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  ANL SSCON,#~20h  ; clear start condition  
 
;  send slave adress and read/write bit  
 
  MOV ACC,slave_adr 
  ;========= 
  SETB RW 
  ;========= 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  JMP end_switch 
 
CASE_18: CJNE R7,#18h,case_20 ; SLR+W was transmitted, ACK bit   
      ; received 
  ; JJJJJJJJJJJJJJJJJJJJJJJJJJJJ 
  MOV R1,DIRECTION 
  CJNE R1,#01H,RECEIVE_DIREC_18 
  ; JJJJJJJJJJJJJJJJJJJJJJJJJJJJ 
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  ANL SSCON,#11110111B ; clear SI  
  MOV SSDAT,ADR_L 
CHECK_FIR: MOV ACC,SSCON 
  JNB ACC.3,CHECK_FIR ; JUMP IF SI = '0' 
 
  ANL SSCON,#11110111B ; clear SI  
  MOV SSDAT,SEC  ; Transmit data byte, ACK bit received  
  JMP end_switch 
 
RECEIVE_DIREC_18: 
  MOV SSDAT,ADR_L 
  LJMP end_switch 
 
CASE_20: CJNE R7,#20h,case_28 ; SLR+W was transmitted, NOT ACK bit  
      ; received 
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_28: CJNE R7,#28h,case_30 ; DATA was transmitted, ACK bit received 
 
  ; JJJJJJJJJJJJJJJJJJJJJJJJJJJJ 
  MOV R1,DIRECTION 
  CJNE R1,#01H,RECEIVE_DIREC_28 
  ; JJJJJJJJJJJJJJJJJJJJJJJJJJJJ 
 
  ORL SSCON,#10h  ; send STOP  
  MOV STOP_BACKUP,SSCON ; BACKUP 
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
RECEIVE_DIREC_28: 
  ORL SSCON,#20h  ; send start  
  JMP end_switch 
 
CASE_30: CJNE R7,#30h,case_38 ; DATA was transmitted, NOT ACK bit  
      ; received 
  ORL SSCON,#10h  ; Transmit STOP  
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_38: CJNE R7,#38h,case_40 ; Arbitration lost in SLA+W or DATA.  
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_40: CJNE R7,#40h,case_58 ; As soon as, the DATA will move to  
      ; SSDAT SFR. 
  ANL SSCON,#11110111B ; clear SI 
S40:  MOV ACC,SSCON 
  JNB ACC.3,S40  ; JUMP IF SI = '0' 
  MOV SEC_R,SSDAT ; Master will send ACK or NACK to slave 
 
  ;================================ 
  ;ORL SSCON,#00000100B ; set AA  */ SENT ACK 
  ANL SSCON,#11111011B ; CLR AA  */ SENT NACK  ( DEFAULT USED )
  ;================================ 
 
  LJMP end_switch 
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CASE_58: CJNE R7,#58h,case_5X  
  ORL SSCON,#00010000B ; send STOP  
  MOV STOP_BACKUP,SSCON ; BACKUP 
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_5X: 
end_switch: ANL SSCON,#11110111B ; clear SI flag  
  RETI 
 
; ************************************************ 
;  DELAY    
; ************************************************ 
DELAY:  MOV R7,#9 
D1:  MOV R6,#5 
D2:  NOP 
  NOP  
  DJNZ R6,D2 
  DJNZ R7,D1 
  RET 
 
; ************************************************ 
;  DELAY  
; ************************************************ 
DELAYS:  MOV R7,#25 
D1S:  MOV R6,#20 
D2S:  NOP 
  NOP  
  DJNZ R6,D2S 
  DJNZ R7,D1S 
  RET 
  END 
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คําอธิบาย 

 

 จากโปรแกรมขางบนซ่ึงเปนโปรแกรมที่รวมเอา
สวนของการรับ และ การสง เขาไวดวยกัน โดยถาผูอานดู
โปรแกรมไมเขาใจ ผูอานสามารถดูโปรแกรมที่แยกการรับ
และ การสงออกจากกัน ไดจากไฟลโปรแกรมที่อยูใน CD  

 

 ภายในโปรแกรมทางดานบน, ซึ่งการเขียน และ 
การอานขอมูลจากชิป DS1307 นั้นจะเปนแบบทีละไบต 
ซ่ึงรูปแบบการรับ และ สงแสดงดังภาพดานลาง คือ 

 

 
 
 
รูปดานบนในสวนของการอานคาขอมูล จาก RTC ซึ่งจะ
อยูในรูปของการอานคาแบบหลายไบต แต ในที่นี้ผูเขียน
จะรับขอมูลครั้ง ละ 1 ไบต ดังนั้น เมื่อรับขอมูล 1ไบตแล
วจะกระโดดไปสงบิต NACK ในสวนทายทันที 
 

  
 

การตรวจสอบโปรแกรมจะมีพอรต P3 ที่ใช
สําหรับการตรวจสอบโปรแกรมโดยถามีคา 18H ออกทาง
พอรต P3 แสดงวาโปรแกรมนั้นทํางานถูกตอง ไมติด 
Loop ใด Loop หนึ่งในโปรแกรม ซ่ึงคาวินาทีควรจะแสดง
ออกมาอยางตอเนื่องที่พอรต P0  
 
 
 

 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

S
ไบทระบุตําแหนง RTC

011 01 00 0 A aaa aa aa a A

ddd dd dd d A P

คาแอดเดรสเริ่มตนอาน

คาขอมูลไบทแรก

สภ
าวะ

เริ่ม
ตน

สภ
าวะ

สิ้น
สุด

บิต
 รับ

รู

บิต
 รับ

รู

บิต
 รับ

รู
บิต

 R/
W

คาแอดเดรสเพิ่มขึ้น 1
ในทุกๆไบทของขอมูล

S
ไบทระบุตําแหนง RTC

011 01 00 1 A

สภ
าวะ

เริ่ม
ตน

บิต
 รับ

รู
บิต
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W

ddd dd dd d A
คาขอมูลไบท2

บิต
 รับ

รูคาแอดเดรสเพิ่มขึ้น 1
ในทุกๆไบทของขอมูล

คาขอมูลไบทสุดทาย

ddd dd dd 1

บิต
 รับ

รูไมมีการตอบรับเมื่อขอ
มูลถึงไบทสุดทายแลว

d

S
ไบทระบุตําแหนง RTC

011 01 00 0 A aaa aa aa a A ddd dd dd d A P
คาแอดเดรสการเขียน คาขอมูลท่ีตองการเขียน

สภ
าวะ

เริ่ม
ตน

สภ
าวะ

สิ้น
สุด

บิต
 รับ

รู

บิต
 รับ

รู

บิต
 รับ

รู

บิต
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W คาแอดเดรสเพิ่มขึ้น 1
ในทุกๆไบทของขอมูล

ลักษณะลําดับขั้นในการเขียนขอมูลให DS1307 แบบไบทเดียว 

แสดง ลําดับขั้นตอนในการอานขอมูลจาก RTC เบอร DS1307 
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Examples 6:  [TWI_PCF8574A_CONST.ASM]  โปรแกรมนี้เปนการสื่อสารอนุกรมบนบัส I2C ดวยพอรต I2C 
BUS โดยโปรแกรมจะเปนการเขียนขอมูลใหแกชิป PCF8974A ดวยคาคงที่ 0FH ( ผูอานจะตองตอ Hardware ดังแสดงดัง
ภาพดานลาง ) 
 

 
 

 

;********************************************************************* 
; DESCRIBTION : THIS PROGRAM IS ROTATE RIGHT OF PCF8574  
; FILE NAME   : TWI_PCF8574A.ASM 
; COMPILER    : CROSS 32 
; SUPPORT     : AT89C5131 
; DATE        : 7 August 2004 
;********************************************************************* 
 
 CPU "8051.TBL" ; Processor declaration 
 HOF "INT8"  ; Intel 8-bit hexcode 
 INCL    "AT89C5131.SFR"  
 
;********************************************************************* 
; DEFINE BYTE SECTION 
;********************************************************************* 
; 
SLAVE_ADR EQU 21H 
ADR_H  EQU 22H 
ADR_L  EQU 23H 
B_TWI_BUSY EQU 25H ; BIT TYPE 
TWI_DATA_I EQU 26H 
STOP_BACKUP EQU 27H 
TWI_DATA EQU 28H 
;********************************************************************* 
; DEFINE BIT SECTION 
;********************************************************************* 
RW  EQU 00H ; 0=WRITE, 1=READ  ; BIT TYPE 
;********************************************************************* 
 
  ORG 0000H  ; Reset vector 
START:  LJMP BEGIN 
 



                       The Examples of CP-JR51USB V1.0      

 ETT CO.,LTD.                                       30                                     WWW.ETT.CO.TH  

 

 
;************************************************ 
;  INTERRUPT SECTION 
;************************************************ 
  ORG 0043H 
  LJMP TWI_IT 
 
;************************************************ 
  ORG 0100H 
;*************************************************   
;  INITIALIZE PCF8574A 
;*************************************************   
BEGIN:  ORL CKCON0,#00000001B ; 6 CLK PERIOD/MACHINE 
  ORL SSCON,#01000000B ; enable TWI */ 
  ANL SSCON,#01000100B ;  
  SETB EA   ; interrupt enable */ 
  ORL IEN1,#02h  ; enable TWI interrupt */ 
  CLR B_TWI_BUSY 
  MOV TWI_DATA,#0FH  ; data example to send */** 
  MOV ADR_H,#00H 
  MOV ADR_L,#00H 
  MOV STOP_BACKUP,#00H 
  MOV R0,#00H 
  MOV P0,#0FH 
 
LOOP_W:  MOV ACC,STOP_BACKUP ; FIND STOP BIT, IF '1' JUMP 
  JB ACC.4,CONT_W 
 
  JB B_TWI_BUSY,END_IF_W ; jump if b_TWI_busy bit = '1'*/ 
  MOV ACC,SSCON 
  JB ACC.4,END_IF_W ; jump if acc.4 bit = '1' "STOP FLAG" 
      ; usually not jump*/ 
  SETB B_TWI_BUSY  ; flag busy =1 , now, I'm not Empty.*/ 
  MOV SLAVE_ADR,#01110000B; slave adresse example  
  CLR RW   ; 0= WRITE 
  MOV SSDAT,#00h  ; clear buffer before sending data 
  ORL SSCON,#00100000B ; TWI start sending */ after that SI bit 
      ; is set '1' 
      ; and  the status code in SSCS will be  
      ; 08h. 
 
  JMP LOOP_W 
; ************************************************ 
CONT_W: MOV STOP_BACKUP,#00H 
  MOV P0,#55H 
  SJMP $ 
END_IF_W: JMP LOOP_W 
 
; ************************************************ 
;  INTERRUPT SERVICE ROUTINE 
; ************************************************ 
TWI_IT:  MOV R7,SSCS 
 
; ************* TWI status tasking *************** 
    
CASE_00: CJNE R7,#00h,CASE_08 ; A start condition has been sent  
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  CLR B_TWI_BUSY  ; TWI is free  
  ORL SSCON,#10H  ; SEND STOP 
  LJMP end_switch 
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CASE_08: CJNE R7,#08h,CASE_10 ; A start condition has been sent 
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  ANL SSCON,#~20h  ; clear start condition  
 
;   send slave adress and read/write bit  
 
  MOV ACC,slave_adr 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  LJMP end_switch 
   
CASE_10: CJNE R7,#10h,CASE_18 ; A repeated start condition has been  
      ; sent 
      ; SLR+R/W are transmitted, ACK bit  
      ; received 
  ANL SSCON,#~20h  ; clear start condition  
 
;  send slave adress and read/write bit  
 
  MOV ACC,slave_adr 
  ;========= 
  SETB RW 
  ;========= 
  MOV C,RW 
  MOV ACC.0,C 
  MOV SSDAT,ACC 
  JMP end_switch 
 
CASE_18: CJNE R7,#18h,case_20 ; SLR+W was transmitted, ACK bit   
      ; received 
 
  ANL SSCON,#11110111B ; clear SI  
  MOV SSDAT,TWI_data ; Transmit data byte, ACK bit received  
  JMP end_switch 
 
CASE_20: CJNE R7,#20h,case_28 ; SLR+W was transmitted, NOT ACK bit  
      ; received 
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
 
CASE_28: CJNE R7,#28h,case_30 ; DATA was transmitted, ACK bit received
  ;ANL SSCON,#11110111B ; clear SI  
  ORL SSCON,#10h  ; send STOP  
  MOV STOP_BACKUP,SSCON ; BACKUP 
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_30: CJNE R7,#30h,case_38 ; DATA was transmitted, NOT ACK bit  
      ; received 
  ORL SSCON,#10h  ; Transmit STOP  
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_38: CJNE R7,#38h,case_40 ; Arbitration lost in SLA+W or DATA.  
  ORL SSCON,#10h  ; Transmit STOP 
  CLR b_TWI_busy  ; TWI is free  
  JMP end_switch 
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CASE_40: CJNE R7,#40h,case_58 ; As soon as, the DATA will move to  
      ; SSDAT SFR. 
  ANL SSCON,#11110111B ; clear SI 
S40:  MOV ACC,SSCON 
  JNB ACC.3,S40  ; JUMP IF SI = '0' 
  MOV TWI_DATA_I,SSDAT ; Master will send ACK or NACK to slave 
 
  ;================================ 
  ;ORL SSCON,#00000100B  ; set AA  */ SENT ACK 
  ANL SSCON,#11111011B ; CLR AA  */ SENT NACK  ( DEFAULT USED )
  ;================================ 
  LJMP end_switch 
 
CASE_58: CJNE R7,#58h,case_5X  
  ORL SSCON,#00010000B ; send STOP  
  MOV STOP_BACKUP,SSCON ; BACKUP 
  CLR b_TWI_busy  ; TWI is free 
  JMP end_switch 
 
CASE_5X: 
end_switch: ANL SSCON,#11110111B ; clear SI flag  
  RETI 
 
; ************************************************ 
;  DELAY    
; ************************************************ 
DELAY:  MOV R7,#9 
D1:  MOV R6,#5 
D2:  NOP 
  NOP  
  DJNZ R6,D2 
  DJNZ R7,D1 
  RET 
 
; ************************************************ 
;  DELAY  
; ************************************************ 
DELAYS:  MOV R7,#25 
D1S:  MOV R6,#20 
D2S:  NOP 
  NOP  
  DJNZ R6,D2S 
  DJNZ R7,D1S 
  RET 
  END 
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คําอธิบาย 
 
 จากโปรแกรมดานบนซ่ึงเปนการเขียนขอมูล
ออกไปที่ตัวชิป PCF8574A เพียงอยางเดียว ซึ่งผูอานจะ
ตองตอ Hardware เขากับพอรต I2C BUS ของบอรด 
CP-JR51USB V1.0 ดวยโปรแกรมจึงจะทํางานอยาง
สมบูรณ  
 

 โปรแกรมนี้ถือเปนโปรแกรมที่งายที่สุดก็วาได
เก่ียวกับการใชงาน TWI เนื่องจากวาหลังจากสง Control 
Byte ใหกับชิป PCF8974A แลว ผูอานจะสามารถสงขอ
มูลออกไปแสดงไดเลย ซึ่งมีรูปแบบการสงขอมูลดังนี้ คือ 

 

            รูปแสดง การเขียนคา Output ไปยัง PCF8574A 
 
 สิ่งที่ตองระวังอีกประการหนึ่งก็ คือ รหัส 
Control Byte ของ PCF8574 กับ PCF8574A จะไม
เหมือนกันผูอานตองดูเบอรที่ใชงานใหดี 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

S
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110 01 00 0 A ddd dd dd d A P
คา O/P ไปยังพอรต

สภ
าวะ

เริ่ม
ตน

สภ
าวะ

สิ้น
สุด

บิต
 รับ

รู

บิต
 รับ

รู

บิต
 R/

W

Tip : เนื้อหาเกี่ยวกับ I2C ผูอานสามารถดูไดจาก
หนังสือ “ รูจักและเขาใจ I2C BUS “ ของบริษัท ETT 
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Serial I/O Port (UART) 
 

 การสื่อสารขอมูลดวย  Serial I/O port  ในชิป 
AT89C5131 นั้นจะมีความเหมือนกันกับของชิป 80C52 
คือ มีทั้งโหมดการสื่อสารอนุกรมแบบ Synchronous และ 
Asynchronous ซ่ึงในการสื่อสารแบบ UART นั้นจะมีการ
ทํางาน 3 โหมด ในแบบ Full-duplex ซึ่งหมายความวาผู
อานสามารถสง และ รับ ขอมูลไดพรอมกันโดยที่การสง 
และ การรับ อาจจะใชคา Baud rate ที่แตกตางกันได 
นอกจากนั้นสําหรับชิป AT89C5131 ยังไดเพ่ิม Framing 
error detection ซ่ึงทําหนาที่ ตรวจสอบความผิดพลาดใน
การรับสงขอมูล และ  Automatic address recognition 
ที่ใชในกรณีที่ผูอานตองการใชงานแบบ Multiprocessor 
communication  

 

Framing Error Detection 

 

 Framing bit error detection สามารถใชงาน
ไดกับการสื่อสารแบบ Asynchronous ในโหมด 1 , 2 , 
และ 3 ในการเปดการใชงานคุณสมบัตินี้สามารถทําได
โดยเซ็ตบิต SMOD0 ในรีจิสเตอร PCON ดังแสดงในรูป
ดานลาง คือ 
 

 

แสดง Framing Error Block Diagram 

 

จากรูปดานบน เมื่อคุณสมบัตินี้ทํางาน, คือ ผูอานทําการ
เซ็ตบิต SMOD0 ใหเปน ‘1’ ซ่ึงผลจะทําใหบิตที่ 7 ของรี
จิสเตอร SCON กลายเปนบิต FE ซึ่งจะเปน ‘1’ เมื่อตัวรับ
ขอมูลทําการเซ็กขอมูลที่เขามาในแตละเฟรมแลวมีความ
ผิดพลาดของบิต STOP ( Invalid stop bit ) ซึ่งสาเหตุ
อาจจะมาจากสัญญาณ Noise ในสายสัญญาณ หรือ มี

การสงขอมูลพรอมกันระหวาง 2 CPU ซึ่งสงผลใหขอมูล
ชนกัน และ บิต FE จะเปน ‘0’ เมื่อการตรวจสอบบิต 
STOP ของการสื่อสารอนุกรมนั้นถูกตอง (Valid stop bit) 
ดังนั้น ในการเขียนโปรแกรมของผูใชงานก็ควรจะตรวจ
สอบบิต FE หลังการตรวจสอบ Error ในแตละเฟรมแลว 
ซึ่งถาผลปรากฎวาบิต FE = ‘1’ , ผูอานจะตอง Clear บิต
นี้ดวยการเขียนโปรแกรมของผูอานเอง หรือ รีเซ็ต CPU 
เทานั้น แตถาการตรวจสอบเฟรมขอมูลที่รับมานั้นถูกตอง
บิต FE = ‘0’ ผูอานก็ไมตองเคลียบิต FE แตอยางใด รูป
ดานลางแสดงตัวอยางการรับขอมูลดวย UART โหมด 1  

รูปแสดงการรับขอมูล UART โหมด 1 (ขอมูล 8 บิต) 

 

 จากรูปดานบนจะเห็นวาบิต RI  จะเปน ‘1’ ใน
บิตที่ 8 ซึ่งถาตําแหนงนี้ไมมี Stop บิต ซึ่งหมายความวา
ตรวจพบความผิดพลาดในการรับขอมูล, ผลจะทําใหบิต 
FE เปน ‘1’ ดังแสดงดวยรอยเสนประ 

รูปแสดงการรับขอมูล UART โหมด 2, 3 (ขอมูล 9 บิต) 
 
Automatic Address Recognition 

 

 การเปดใชงานคุณสมบัติ Automatic Address 
Recognition นี้ก็ตอเมื่อผูอานตองการจะใชงานการสื่อ
สารแบบ Multiprocessor Communication ( บิต SM2 
ในรีจิสเตอร SCON = ‘1’ ) ซ่ึงรายละเอียดการใชงานใน 

1) 
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สวนนี้ผูเขียนของไมกลาวในที่นี้ โดยผูอานสามารถหา
อานไดจาก Datasheet หนา 66  

 

Baud Rate Selection for UART for Mode 1 and 3 
 

 ในการกําหนดคา Baud rate ในการรับสงขอมูล
นั้นสัญญาณ Clocks สามารถเลือกไดจากหลายแหลง
ดวยกัน  ซ่ึงกําหนดไดจากรีจิสเตอร T2CON และ 
BDRCON โดยสามารถแบงใหญๆ ได 2 ทาง ไดแก 
 

 Timer 
 Internal Baud rate Generator  ( BRG ) 

 

โดยทางแรก คือ การใช Timer, ซึ่งวิธีนี้เปนวิธีที่ผูอานคุน
เคยเปนอยางดีอยูแลวซึ่ง CPU มาตรฐาน 8051 จะตอง
ใชในการสราง Baud rate แตวิธีนี้ผูอานจะตองเลือก 
Crystal ที่หาคา Baud rate ไดลงตัว ซึ่งไดแก คา 
11.0592 MHz หรือ 18.0432MHz เปนตน มิฉะนั้นจะไม
สามารถสราง Baud rate ที่เปนคามาตรฐานได  

 

ทางที่สอง คือ  การใชงาน Internal Baud Rate 
Generator ซึ่งวิธีนี้ผูอานจะสามารถสรางคา Baud rate 
มาตรฐานได โดยที่ใช Crystal คาอ่ืนๆ นอกเหนือจากวิธี
แรกได เชน 16.384MHz หรือ 24MHz เปนตน ซึ่งบอรด 
CP-JR51USB v1.0 นี้ใชคา Crystal = 24MHz ดังนั้น ตัว
อยางตางๆ ที่เกี่ยวกับการใชงานพอรต UART ผูเขียนจะ
ใชวิธีการนี้ทั้งหมด ( สูตรคํานวณ  Baud rate ดูในรูป
ดานลาง ) 

 
แสดง โครงสรางของ Internal Baud Rate Generator 

 
 

 
 

และ เพ่ือความสะดวกในการใชงาน ตารางดานลางเปน
การสรุปคา Baud rate ที่ Crystal = 16.384MHz และ 
24MHz  
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Examples 7:  [ UART MODE1_INT_BRG.ASM ]  โปรแกรมนี้เปนการใชงาน UART ที่ Baud rate 
=115200bps โดยใชโหมด 1 และ ไมใช Interrupt , ในการรันโปรแกรมนี้ผูอานควรเปดโปรแกรม Procomm 3 หรือ Hyper 
Terminal กอนรันโปรแกรมนี้ และ เซ็ตคา Baud rate ใหตรงกัน, เมื่อรันโปรแกรมผูอานจะเห็นขอความขึ้นบนหนาตาง 
Procomm จากน้ันใหผูอานพิมพตัวอักษรอะไรก็ไดแลวกดปุม Enter ผูอานจะเห็นขอความที่พิมพปรากฎ 

 
 

;********************************************************************* 
; DESCRIBTION :-
; FILE NAME   : UART MODE1_INT_BRG.ASM 
; COMPILER    : CROSS 32 
; SUPPORT     : AT89C5131 
; X'TAL       : 24MHz 
; BAUD RATE   : 115200bps 
; DATE        : 6 SEPTEMBER 2004 
; MODE       : UART MODE1 INTERNAL BAUD RATE GENERATOR,NO USED INTERRUPT 
;********************************************************************* 
 
 CPU "8051.TBL"   ; Processor declaration 
 HOF "INT8"    ; Intel 8-bit hexcode 
 INCL    "AT89C5131.SFR"  
 
;********************************************************************* 
; DEFINE SECTION 
;********************************************************************* 
BUFFER_RX EQU 70H 
COUNT_RX EQU 6FH 
;********************************************************************* 
 
  ORG 0000H   ; Reset vector 
START:  LJMP BEGIN 
 
;************************************************ 
;  INTERRUPT SECTION 
;************************************************ 
 
;************************************************ 
  ORG 0100H 
   
BEGIN:  MOV     SP,#256-32            ; define stack = 32 byte 
  ORL CKCON0,#00000001B ; 6 CLK PERIOD/MACHINE 
  ORL PCON,#11000000B ; ENABLE THE FRAMING BIT ERROR DETECTION,  
      ; DOUBLE BAUD RATE 
      ; AND CHECK FE BIT OF SCON SFR 
  ORL BDRCON,#00001110B ; SPD=1,RBCK =1, TBCK =1 
  MOV SCON,#01010000B ; uart in mode 1 (8 bit), REN=1  
  MOV BRL,#243  ; U CAN SEE THIS VALUE FROM PAGE 71 OF 
      ; DATASHEET 
  ORL BDRCON,#00010000B ; BRR = 1 , START BAUD RATE RUN 
  ;======================== 
  ; TRANSMITION 
  ;======================== 
  MOV DPTR,#TEXT_1 
  ACALL TRANSMIT 
 
  ;======================== 
  ; RECEIVER 
  ;======================== 
  MOV R0,#BUFFER_RX 
  ACALL RECEIVE 
 
  MOV A,R0 
  MOV R0,#BUFFER_RX 
  ;======================== 
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  ;======================== 
  ; TRANSMITION 
  ;======================== 
REPLY:  CLR TI 
  MOV SBUF,@R0 
  JNB TI,$ 
  CLR TI 
  INC R0 
  CJNE A,00H,REPLY  ; 00H = RO 
  ;======================== 
  ; SEND ENTER 
  ;======================== 
  MOV DPTR,#ENTER 
  ACALL TRANSMIT 
  JMP BEGIN 
 
;********************** ROUTINE: TX ***************************************** 
;   INPUT : DPTR  ; DEFINE TEXT LOCATION 
;   OUTPUT : -    
;**************************************************************************** 
TRANSMIT: CLR TI   ; Clear TI 
TX_LOOP: CLR A   ; Clear ACC. 
  MOVC A,@A+DPTR  ; Get Data from ROM with Pointer 
  INC DPTR   ; Increase Pointer 
  CJNE A,#0FFH,TX_CHAR ; Check 0FFH End of Text Char. 
  RET    ; End => Return 
 
TX_CHAR: MOV SBUF,A   ; Send Data to SBUF 
  JNB TI,$   ; Wait until TX already (TI=1) 
  CLR TI   ; Clear TI 
  AJMP TX_LOOP   ; Jump to TX_LOOP 
 
;********************** ROUTINE: RX ***************************************** 
;   INPUT : R0  ; DEFINE BUFFER ADDRESS 
;   OUTPUT : ADDRESS 70H....    
;**************************************************************************** 
 
RECEIVE: SETB REN   ; Set RX Enable 
RE_LOOP: JNB RI,$   ; Wait received 1 byte FROM KEY BOARD[ JUMP IF 
      ; BIT RI = '0'] 
  CLR RI   ; CLEAR RECEIVE INTERRUPT FLAG 
;  **************************** 
;  FRAMEING BIT ERROR DETECTION 
;  **************************** 
  MOV ACC,SCON 
  CLR SCON.7 
  JB ACC.7,RE_LOOP  ; JUMP IF SCON.7(FE) = '1' 
;  **************************** 
  MOV A,SBUF   ; Get byte from SBUF 
  MOV @R0,A   ; KEEP 1 BYTE DATA TO MEMORY 70H 
  CJNE A,#0DH,INC_R0  ; Check Enter key receive? [IF REG "A" UNEQUAL 
      ; 0DH JUMP] 
  RET 
;  ************************ 
;  COUNT THE AMOUNT WORDS 
;  ************************ 
INC_R0:  INC R0   ; Increase pointer 
  AJMP RE_LOOP   ;  
 
; ************************************************ 
;  SEND ENTER  
; ************************************************ 
ENTER:   DFB 0AH,0DH,0FFH 
 
; ************************************************ 
;  DELAY   
; ************************************************ 
DELAY:  MOV R7,#50 
D1:  MOV R6,#50 
D2:  NOP 
  NOP  
  DJNZ R6,D2 
  DJNZ R7,D1 
  RET 
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คําอธิบาย 
 

 จากโปรแกรมดานบนผูอานจะเห็นวา ในสวน
ตนของโปรแกรมกําหนดใหการทํางานเปนแบบ 6 
clk/Machine cycle และ กําหนดการทํางานของ UART 
เปนโหมด 1 ( 8 bit ) และ กําหนดคาในรีจิสเตอร BRL = 
243 ซึ่งเปนการกําหนดคา Baud rate ใหมีคาเทากัน 
115200 bps  จากน้ันสั่งรัน ดวยการเซ็ตบิต BRR = ‘1’ 
แลวสงขอความ TEXT_1 ซึ่งมีขอความวา  “ Please, 
Press any key.<15 Charactor are limited> ”  จากน้ัน 
ใหผูอานพิมพตัวอักษรอะไรก็ได ไมเกิน 15 ตัวอักษร  
จากนั้นกดปุม Enter , ขอมูลที่พิมพจะปรากฎบนจอภาพ 
ซ่ึง ในสวนของการรับจะมีรีจิสเตอร R0 เปนตัวชี้ตําแหนง
การเก็บคาตัวอักษร 
 
 
 

; ************************************************ 
;  MESSAGE   
; ************************************************ 
TEXT_1:  DFB 0AH,0DH 
  DFB "Please,Press any key.<15 Charactor are limited>",0AH,0DH,0FFH 
  END 
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ภาคผนวก ก. 
การติดต้ัง และ การใชงานภาษา C (Keil) เบ้ืองตน 



        The Examples of CP-JR51USB V1.0        

 ETT CO.,LTD.                                      II                                    WWW.ETT.CO.TH  

 

 เนื้อหาภายในภาคผนวก ก. นี้อธิบายเกี่ยวกับการติดตั้ง และ การใชงาน Keil Compiler เบื้องตน 
ซึ่ง Keil Compiler นี้สามารถใชงานไดกับ Windows95, Windows98, WindowsNT, Windows2000, 
Windows XP 
 โปรแกรม Keil ที่ผูเขียนจะนําเสนอนี้เปนเวอรชั่นทดลองใช 7.10 ซึ่งเวอรชั่นนี้ผูอานสามารถดาวน
โหลดไดจาก www.keil.com ซึ่งขั้นตอนการติดตั้งทําไดดังนี้ คือ 
 
 
ข้ันที่ 1 : เปด CD-ROM และ  Double-click ที่ไฟล EK51V710.exe ในโฟลเดอร Tools 
 

 
 
ข้ันที่ 2 : กดปุม Yes เพ่ือทําขั้นตอนการติดตั้งโปรแกรม หลังจากนั้นกดปุม Next  และ Yes ไปเลื่อยๆ 

 

 
 
ข้ันที่ 3 : เมื่อผูอานทําตามขั้นตอนจนมาถึงไดอะล็อก “ Choose Destination Location” ดังแสดงในรูปดาน
ลาง ผูอานสามารถเปลี่ยนแปลงตําแหนงที่จะติดตั้งโปรแกรมได แตในที่นี้ผูเขียนไมเปล่ียนแปลงใดๆ 
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ข้ันที่ 4 : จากนั้น กดปุม Next ไปเลื่อยๆ จนส้ินสุดการติดตั้งโปรแกรมโดยกดปุม Finish เปนอันเสร็จพิธี 
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การใชงาน Keil เบ้ืองตน 
 

 ในหัวขอนี้ผูเขียนจะนําผูอานเขาสูการเขียนโปรแกรมดวยภาษา C โดยใชเครื่องมือชื่อ 2Visionµ  
ซึ่งเวอรชั่นนี้จะเปนเวอรชั่นทดลองใช หรือ เปนเวอรชั่นที่ลิมิตขนาดของโคดโปรแกรมที่จะใช Compile ใน
โปรแกรม 2Visionµ  นี้  
 
การสรางโปรเจ็คไฟล ( Creating Projects ) 
 

 ภายใน 2Visionµ  จะมีสวนของ Project manager ซึ่งจะทําใหการออกแบบ หรือ การพัฒนา
โปรแกรม กับ CPU ตระกูล 8051 ของผูใชนั้นทําไดงาย และ สะดวกมากยิ่งขึ้น ซึ่งการสรางโปรเจ็คไฟลทํา
ไดดวยขั้นตอนตอไปนี้ คือ 
 

ขั้นที่ 1. เปดโปรแกรม 2Visionµ  จาก Icon บน Desktop  
ขั้นที่ 2. ทําการสรางโปรเจ็คไฟลใหม โดยเลือก Project => New Project… จากเมนู ซึ่งหนาตางที่ข้ึนมา
จะใหผูอานตั้งชื่อ New Project File ดังแสดงในรูปดานลาง 

 

 
 
 
 
 
 
 
ขั้นที่ 3. จากนั้นกดปุม Save หลังจากนั้นโปรแกรมจะใหอานเลือกเบอรอุปกรณที่ผูอานใชงาน ซึ่งในที่นี้ผู
เขียนใช CPU ของบริษัท Atmel เบอร AT89C5131 จากนั้นกดปุม OK 
 

Tip : ผูเขียนแนะนําวาควรจะสราง Folder  สําหรับแตละ Project  ดวยการกดที่ Icon  (ดูรูปดานบน) 
จากนั้นใหพิมพชื่อ New Project ลงในชอง File name เชน test ซ่ึง 2Visionµ จะสรางไฟล 
test.UV2 ข้ึนมาให 
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การสรางไฟลโคด ( Creating New Source Files ) 

 

ขั้นที่ 4. เมื่อมาถึงตรงนี้ ผูอานไดทําการสราง Project file ใหมเปนที่เรียบรอยแลว ตอไปผูอานจะตองสราง 
Source file ใหมข้ึนมาโดยไปที่เมนู File => New ซึ่งผูอานจะได Editor window เปลาๆ มา 1 แผน ซึ่งผู
อานสามารถจะเขียนโคดของผูอานลงไปได, จากนั้นทําการ Save โดยไปที่เมนู File => Save as… จาก
นั้นใสชื่อ แลวตามดวยนามสกุล .C ในที่นี้ผูเขียน Save ชื่อ main.c 
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ขั้นที่ 5. จากนั้นใหผูอานเพิ่ม Source file ( ที่ไดเขียนไวกอนนี้ ) เขามาใน Project ซึ่งทําไดหลายวิธีในการ
ที่จะเพิ่ม Source file เขามาใน Project เชน Click ขวาที่โฟลเดอร Source Group1 จากนั้นเลือก add files 
to Group ‘Source Group 1’  แลวตามดวยเลือกไฟล main.c จากนั้นกดปุม Add 
 

 
 

ขั้นที่ 6. จากโปรแกรมในขั้นตอนที่ 4 ผูอานจะเห็นวามีการเรียกใชงานฟงกชั่นชื่อ roll ซึ่งผูเขียนไดสรางไว
อีกไฟลหนึ่งชื่อ Function.C ซึ่งภายในไฟลนี้จะมี 2 ฟงกชั่น คือ ฟงกชั่น roll และ ฟงกชั่น delay ซึ่งเขียนได
ดังนี้ คือ  
 
 
 
 
 
 
 
 
 
 
 
 

 ภายในจะมีไฟล main.c 

 
// ===== Include Part ========== 
#include <reg51.h>      // Tool will fine in Path :" C:\Keil\C51\INC " 
 
// ===== Declare Function ====== 
void delay();   // Necessary 
void roll();   // Necessary 
 
// ***************************** 
//  Subprogram 
// ***************************** 
void roll(void) 
{ 
 unsigned char i; 
  if(i == 0) {i=0x80;} 
 
  P2 = i; 
  delay(); 
  i >>= 1; 
} 
// ***************************** 
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ขั้นที่ 7. ใหผูอานเปด Editer แผนใหมข้ึนมาจากเมนู File => New… แลวพิมพโคดโปรแกรมในขั้นที่ 6 
จากนั้นทําการ Save จากเมนู File => Save as… โดยตั้งชื่อวา Function.C  
 

 
 
 
ขั้นที่ 8. จากนั้นผูเขียนจะสรางโฟลเดอรใน Project file อีก 1 อันชื่อ Function ซึ่งจะใชเก็บไฟล Function.c 
ในความเปนจริงผูอานไมจําเปนตองสรางโฟลเดอร Function ก็ไดโดยรวมไฟล Function.c ไวในโฟลเดอร
เดียวกับไฟล main.c แตทั้งนี้เพื่อการจัดกลุมไฟลใหเปนหมวดหมูมากยิ่งขึ้น ใหผูอานไปที่เมนู Project => 
Components,Environment, Books  
 

 
// ***************************** 
//  Subprogram 
// ***************************** 
void delay(void) 
{ 
 unsigned int i; 
  
 i = 50000; 
 while(i>0) {i--;} 
 return; 
} 
// ***************************** 



        The Examples of CP-JR51USB V1.0        

 ETT CO.,LTD.                                      VIII                                    WWW.ETT.CO.TH  

 

 
 
 

ขั้นที่ 9. ใหผูอานสรางโฟลเดอรโดยกดที่ Icon   แลวใสชื่อ Function จากนั้นใหคล๊ิกที่ชื่อ Function 
เพื่อทําใหมีแถบสีข้ึนมา แลวกดปุม Add Files  
ขั้นที่ 10. ใหเลือกไฟล Function.c แลวกดปุม Add และ Close ตามลําดับ 
ขั้นที่ 11. กดปุม OK เพื่อออกจากหนาตาง Components,Environment, Books 
ขั้นที่ 12. ใหผูอานดูใน Project Wrokspace – Files ผูอานจะเห็นวามีโฟลเดอร Function และ ภายในมี
ไฟล Function.c เพ่ิมเขามา 
 
 

 
 

9 

10 

Note : รายละเอียดเกี่ยวกับไฟล 
Startup.a51 ผูใชสามารถหาอาน
ไดจากไฟลชื่อ GS51.pdf ในโฟล
เดอร Datasheets\Get start keil 
file ในบทที่ 10 หนา197 ใน CD 
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ขั้นที่ 13. จากนั้นผูอานจะตองกําหนดคาตางๆของ Hardware โดยไปที่เมนู Project => Option for 
Target ’Target 1’ และ คลิ๊กแทบ Target 

 

 
 
 
 
 
 
 
 
 

ขั้นที่ 14. จากนั้นไปที่แทบ Output แลว ติ๊กที่ชอง Create HEX File จากนั้นกดปุม OK 
 
 

 
 
 

กําหนดคาความถี่ x’tal
โดยทั่วไปผูอานไมตอง
เปลี่ยนแปลงก็ได 

กรณี CPU AT89C5131 
ซึ่งภายในมี XRAM = 1k 
ผูอานจะตองติ๊กในชอง 
User On-chip XRAM… 

Note : รายละเอียดอ่ืนผู
อานสามารถอานไดจาก
หนา 62 ในไฟล GS51.pdf 
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ขั้นที่ 15. จากนั้นใหผูอานไปที่เมนู Project => Rebuild all target files เพ่ือทําการ Compile ซึ่งผูอานได
ไดไฟล test.Hex มาถาการ Compile ไมมี Error ......!! 
 

 
 
 เมื่อมาถึงตรงนี้ผูเขียนหวังวาผูอานจะสามารถใชงาน C Compiler ของ Keil ไดในระดับหนึ่งแลว 
เพื่อเปนจุดเริ่มตนสําหรับผูที่เริ่มตนที่จะเขียนโปรแกรมภาษา C กับ Microcontroller ในตระกูล 8051 ซึ่งถา
เนื้อหามีขอผิดพลาดประการใดก็ขอนอมรับไว ณ. ที่นี้ 
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ภาคผนวก ข. 
การติดต้ัง และ การใชงาน Cross 32 V4.0 เบ้ืองตน 
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การติดต้ังโปรแกรม Cross 32 V4.0 
 

 โปรแกรม Cross 32 นั้นจัดเปนโปรแกรมครอสแอสแซมเบอร (Cross-Assembler) ถูกพัฒนาโดย
บริษัท “ Data Sync Engineering” โปรแกรมตัวนี้มีจุดเดนที่หนาสนใจตรงที่มันเปนโปรแกรมจําพวก 
Universal Cross-Assembler ซึ่ง สามารถใชแปลงคําสั่งไดทั้ง CPU Mcs51, Z80 และ อีกหลายๆ ตระกูล 
ซึ่งโปรแกรม Cross 32 ที่ทางบริษัทแถมไปใหพรอมกับบอรดนั้นจะเปน Version ทดลองใชงาน การติดตั้ง
โปรแกรม Cross 32 ใน Version ทดลองใชนี้ติดตั้งงายมาก เพียงแค Copy ไฟลโปรแกรม Cross 32 ไปวาง
ไวใน ไดร C (ไดรไหนก็ได) แคนี้ก็เปนอันเสร็จเรียบรอย เมื่อตองการจะเปดโปรแกรมก็เพียงแค Double 
Click ที่ไฟล C32w4w95.exe ซึ่งเปนรูปไอคอนสีแดง ดังแสดงในรูปขางลาง 
 
 
 
 
 
 
 
 
 
 
      รูปที่ 1 
 
 

สิ่งสําคัญอีกประการหนึ่ง คือ ใน Folder ที่ใชเก็บโคดโปรแกรม (ที่ผูอานไดพัฒนาขึ้น) ซึ่งจะเปน
ไฟลนามสกุล .ASM จะตองทําการ Copy ไฟล 8051.tbl ไวใน Folder นั้นดวย ถาอยางนั้นเวลาทําการ
แปลงไฟลจะเกิด error  
 
การใชงานโปรแกรม Cross 32 V4.0 
 

 โปรแกรม Cross 32 เปนโปรแกรม Assembler ที่มี Text Editor ในตัว ดังนั้น ผูใชสามารถทําการ
พัฒนาโปรแกรมไดจากโปรแกรมนี้เลย หรือ ผูใชจะใชโปแกรม Notepad หรือ โปรแกรม Text Editor อ่ืนๆ ก็
ได แตในที่นี้ผูเขียนจะอธิบายการใชงานโปรแกรม Cross 32 พอสังเขป โดยใช Text Editor ที่มีในตัว 
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โปรแกรมนี้เลย ซึ่งถาผูอานตองการรายระเอียดของกฎเกณฑการใชงานตางๆ ของโปรแกรมนี้ผูอานสามารถ
หาอานไดจากหัวขอ ” ภาคผนวก ค. คําส่ังเทียมใน Cross 32 V4.0 ”  จากนั้นเปดโปรแกรม Cross 32 
ข้ึนมา และ click ที่เมนู File => New จะมีหนาตาง ดังแสดงในรูปขางลาง  
 

 
 
 
 
 
 
 
 
 
 
 
     

รูปที่  2 
 

 เมื่อเริ่มตนเขียนโปรแกรม, 2 บรรทัดแรกของโปรแกรมผูอานจะตองกําหนดคําสั่งเทียมของเบอร 
CPU และ ชนิดของ Output File ใหกับโปรแกรมเสียกอนเนื่องจากโปรแกรม Cross 32 สามารถใชงานกับ 
CPU ไดหลายเบอร และ นอกจากนั้นยังสราง Output File ไดหลาย Format ดังนั้น สําหรับ บอรดทดลอง 
CP-JR51-USB v1.0  นี้ใช MCU เบอร AT89C5131 ซึ่งมีการทํางานหลัก (Core) แบบ 8052 ดังนั้น จึงใช
งานไดกับชุดคําส่ัง 8051 แตผูอานจะตองไปเพิ่มรีจิสเตอร SFR บางตัวที่อยูนอกเหนือจากตัวมาตรฐาน 
8052 โดยดูไดจากตัวอยางในหัวขอตอๆ ไป ซึ่งไฟลสวนหัวเขียนไดดังนี้ คือ 
 
 
 
  
 

หลังจาก 2 บรรทัดขางบนแลวในบรรทัดตอมาจะเปนพื้นที่ของโปรแกรมของผูใช โดยหลักการเขียน
โปรแกรมคราวๆ มีหลักดังนี้คือ 
 

CPU “8051”  ; แปลเปน Code คําสั่งของ MCS-51 
HOF "INT8"  ; สราง Output File เปนแบบ Intel Hex 8 bit 
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• การเริ่มตนโปรแกรมจะตองขึ้นตนดวยคําส่ังเทียม ORG 0000H ซึ่งมีความหมายวา เปนการ
กําหนดตําแหนงเริ่มตนของหนวยความจําโปรแกรม และ จะตามดวย Address เริ่มตนซึ่งในที่นี้คือ 
Address 0000H การเขียนหามเขียนชิดทางซายสุดตองเวนวรรคอยางนอย 1 ตัวอักษร 

• การกําหนดคาคงที่ใหกับตัวแปรนั้นสามารถทําไดโดยใชคําส่ังเทียม EQU ซึ่งดูไดจากตัวอยางขาง
ลาง โดย ชื่อตัวแปลจะตองอยูชิดทางซายมือสุด ( หามเวนวรรค )   

• ในการเขียน Label จะใชเปนตัวกําหนดตําแหนงอางอิงใหกับ Address ของหนวยความจํา
โปรแกรม โดยส่ิงที่ตองระวัง คือ จะตองใสเครื่องหมาย “ : “  ตอหลังชื่อ Label โดยหามเวนวรรค 
และ ตัวอักษร “&” หามใชในการเขียน Label 

• ในการเขียนโปรแกรมคําส่ังตางๆ เชน MOV A,#3EH คําสั่งจะตองเวนวรรคอยางนอย 1 ตัวอักษร
จากทางซายมือเสมอ 

• เมื่อเขียนโปรแกรมจนถึงบรรทัดสุดทายจะตองปดดวยคําส่ัง END ซึ่งเปนคําสั่งจบโปรแกรม ซึ่งจะ
บอกใหตัวแปลภาษาหยุดการแปลโปรแกรม ซึ่งถาไมมีคําสั่งนี้อาจจะทําใหการแปลภาษาเกิดความ
ผิดพลาดได 

 
Example : ตัวอยางขางลางนี้เปนตัวอยางไฟวิ่งออกทางพอรต 0 โดยการวิ่งจะว่ิงไปทางขวา 
 
  
 
 
 
 
 
 
 
 
 

รูปที่ 3 แสดงโปรแกรม ShowP0.asm 
 

เมื่อเขียนโปรแกรมเสร็จแลว ใหผูใช Save As ไฟล ซึ่งในที่นี้ผูเขียนจะ Save ไวที่ ไดร D:\Exam51 
แลว ตั้งชื่อ ในชอง File name ชื่อ ShowP0.asm จากนั้นกดปุม OK ซ่ึงแสดงไดดังรูปขางลาง คือ 

   
  CPU "8051.TBL" ; Processor declaration 
   HOF "INT8"  ; Intel 8-bit hexcode 
 
   ORG 0000H  ; Reset vector 
DATA     EQU 0FEH 
START:  MOV A,#DATA ; DEFIND FIRST VALUE 
loop:    RR  A 
         MOV P0,A 
         MOV R2,#100 
L1:     mov    R3,#5h 
L2:      mov    R4,#5h 
         djnz   R4,$ 
         djnz   R3,l2 
         djnz   R2,L1 
    sjmp   loOP 
 
         END 
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รูปที่ 4 รูปแสดงการ Save ไฟล 
 
จากนั้นให Copy ไฟล 8051.tbl ไวในโฟลเดอร Exam51 ดวย โดยไฟลนี้จะอยูในโฟลเดอร c32win ดังแสดง
ในรูปขางลาง 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 5 

 

หลังจากนั้นจะเริ่มตนแปลโปรแกรมกันเลยโดยใหผูอานไปที่เมนู Assemble => Mail File… เพ่ือกําหนด
ไฟลที่ตองการแปลเปนไฟล .HEX จากนั้นเลือกไปที่ไฟล D:\Exam51\ ShowP0.asm และ กดปุม OK จาก
นั้นใหไปที่เมนู Assemble => Asseble… จะปรากฎดังภาพขางลาง จากนั้นใหกดที่ปุม Assemble ซึ่งผูใช
จะตองสังเกตในชอง Error: จะตองเปน 0 ถาเปนตามนี้แสดงวาการแปลโปรแกรมนั้นสมบูรณ ซึ่งในโฟล
เดอร Exam51 จะมีไฟลเพ่ิมข้ึนมา 3 ไฟล คือ ShowP0.ERR, ShowP0.HEX, ShowP0.LST ซึ่งถึงตรงจุดนี้
ผูใชจะไดไฟล .Hex แลว...!!! 
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รูปที่ 6 
 

รูปที่ 6 
 
 จากที่กลาวมาทั้งหมดหวังวาผูอานจะสามารถใชงานโปรแกรม Cross 32 ได ในระดับหนึ่งแลว เพื่อ
เปนจุดเริ่มตนสําหรับผูอานที่ไมเคยใชโปรแกรมนี้มากอน ความผิดพลาดของเนื้อหาใดๆ ทางผูเขียนตองขอ
อภัยไว ณ. ที่นี้...!! 
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ภาคผนวก ค. 
คําสั่งเทียมใน Cross 32 V4.0  
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 การเขียนภาษา Assembly นั้นจะมีความยุงยากกวาการเขียนภาษาระดับสูงอื่นๆ โดยเฉพาะอยาง
ย่ิง เมื่อตองการเรียกขอมูลของหนวยความจําออกมาใชจะเปนการยุงยากอยางมากวาตําแหนง Address 
ใดถูกจัดสรรหนวยความจําไวสําหรับเก็บคาขอมูลอะไรบาง และ ยังอาจเกิดความสับสนในขณะที่เรียกใชได 
ทําใหเกิดความผิดพลาดขึ้นไดงาย ดังนั้น เพ่ือความสะดวก โปรแกรมที่ทําหนาที่เปนตัว Assembler ตางๆ 
จึง มีการคิดคนสรางคําสั่งอีกกลุมหนึ่งขึ้นมาเพื่ออํานวยความสะดวกใหกับผูเขียนโปรแกรม โดยกลุมคําส่ัง
ดังกลาวนี้นิยมเรียกกันทั่วๆ ไปวา คําส่ังเทียม ซึ่งคําสั่งเทียมนี้จะไมใชคําส่ังสําหรับสั่งงาน CPU แตจะถูกนํา
มาใชเพ่ือบงบอกใหโปรแกรม Assembler ไดทราบถึงสิ่งที่ไดกําหนดขึ้น เพื่อนําไปใชในการแปลโปรแกรม
เทานั้น ซึ่งคําสั่งเทียมของ Cross32 นั้นมีอยูมากมาย แตในที่นี้จะขอกลาวถึงเฉพาะในสวนของคําส่ังเทียม
ที่มีความจําเปน และ ใชงานกันบอยใหทราบพอสังเขป คือ 
 
1. คําส่ัง ORG (Origin) 
 คําสั่ง ORG นี้เปนคําสั่งที่ใชกําหนดคาเริ่มตนของหนวยความจําโปรแกรม และ หนวยความจําขอ
มูล โดยตัวเลขที่อยูถัดจากคําสั่ง ORG นี้จะเปนตําแหนงเริ่มตนของโปรแกรม เชน 
 
 
 
 
 
 
2. คําส่ัง EQU (Equate) 
 เปนคําสั่งที่ใชกําหนดคาคงที่ใหกับตัวแปร ปกติคําสั่งนี้จะอยูในสวนตนของโปรแกรม โดยคําส่ัง 
EQU จะชวยในการกําหนดคาตัวแปรของคาตําแหนง Address หรือ คาตางๆ ได ดังแสดงในตัวอยางขาง
ลาง คือ  
 

 
 
 

 

  ORG  0000H 
Main:  MOV SP,#60H 
  . 
  . 

PORT_A: EQU 20H 
PORT_B: EQU PORT_A+1 
PORT_C: EQU PORT_A+2 
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จากตัวอยางขางบน ในทุกๆ ตําแหนงของโปรแกรมที่มีการอางถึง PORT_A จะมีความหมาย
เหมือนกับอางถึงคา 20H เสมอ สวนคาของ PORT_B และ PORT_C จะมีคาเปน 21H และ 22H ตาม
ลําดับ ถามีการเปล่ียนแปลงคาของ PORT_A เปนคาอ่ืนๆ ก็จะสงผลให PORT_B และ PORT_C ถูกเปล่ียน
แปลงคาตามไปดวย ซึ่งลักษณะของคําสั่ง EQU จะเหมือนกับการกําหนดคา Constant ในภาษาสูงนั้นเอง 
 
3. คําส่ัง DFB (Define Byte) 
 เปนคําสั่งที่ใชกําหนดคาขอมูลคงที่ขนาด 1 Byte ไวในหนวยความจําโปรแกรม โดยคําส่ังนี้จะถูก
นํามาใชประโยชนในการกําหนด ตาราง TABLE ตางๆ ที่จะนํามาใชในโปรแกรมโดยจํานวนขอมูลแตละคา
จะถูกแบงแยกออกจากันดวยเครื่องหมาย คอมมา(,) ดังแสดงในตัวอยางขางลาง คือ 
 
 
 
 
 
 
 จากตัวอยางที่ผานมาเมื่อสั่งใหโปรแกรม Assembler แปลโปรแกรมแลว ที่ตําแหนง Address ของ 
TAB_LED จะมีคาคงที่อยู 4 ไบต คือ 01H, 02H, 04H และ 08H เรียงตอเนื่องกันไป สวน TAB_MSG จะได
คาเปนรหัส ASCII ของตัวอักษร ABC เรียงกันไป คือ 41H, 42H, 43H และ ปดทายดวย 00H 
 
4. คําส่ัง DWL (Define Word : LSB First ) 
 เปนคําสั่งที่ใชสําหรับกําหนดขอมูลคาคงที่ ขนาด 2 ไบต (Word) โดยตองกําหนด คาของ Byte ต่ํา
กอนแลวจึงตามดวย Byte สูง และ แบงแยกขอมูลแตละ Word ดวยเครื่องหมาย คอมมา (,) 
 
5. คําส่ัง DFS (Define Storage)  
 เปนคําสั่งที่ใชสําหรับจองพ้ืนที่ของหนวยความจําโปรแกรม โดยจะจองเทากับ จํานวนตัวเลขที่ระบุ
ไวหลังคําส่ัง DFS เชน 
 
 
 
 

 

TAB_LED: DFB 00000001B 
 DFB 02H,04H,08H 

TAB_MSG: DFB “ABC”,00H 

ORG 0000H 
DSP_BUFF: DFS 4 
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 จากตัวอยางขางบนจะเปนการบอกใหโปรแกรม Assembler ไดทราบวาชื่อ DSP_BUFF นั้น ถูก
กําหนดใหมีขนาดของหนวยความจํา 4 ไบต โดยมีตําแหนง 0000H – 0003H ซ่ึงถามีการอางถึงชื่อ 
DSP_BUFF นี้ในโปรแกรมก็จะมีความหมายเหมือนกับการอางถึงคาตําแหนง Address 0000H – 0003H 
ดวย โดยถาใชการอางแบบ 8 บิต เมื่อตองการใชตําแหนงที่ 2 ของชื่อ DSP_BUFF ก็อาจจะใชรูปแบบเปน 
DSP_BUFF+1 แทนได ซึ่งจะเปนประโยชน มากในการเขียนโปรแกรมเพราะสามารถสื่อความหมายถึงหนา
ที่ของหนวยความจําไดดีกวาการอางเปนคาตัวเลข และ ยังงายตอการเปลี่ยนแปลงแกไขตําแหนง Address 
ในหนวยความจําดวย 
 
6. คําส่ัง END 
 เปนคําสั่งที่ใชสําหรับบอกให Assembler ทราบวาไดถึงจุดส้ินสุดการแปลโปแกรมแกรมแลวซึ่งตอง
มีคําส่ังนี้ไวทายของโปรแกรมเสมอ และ หากเขียนโปรแกรมตอหลังจากคําสั่ง END นี้ Assembler จะไม
แปลสวนที่ตอจาก คําสั่ง END นี้ให 
 
7. คําส่ัง HOF (HEXADECIMAL OUTPUT FORMAT)  
 เปนคําสั่งที่ใชสําหรับกําหนดรูปแบบของ Output File โดย กําหนดได 3 ลักษณะ คือ Binary 
Output, Intel Hex Output, Motorola Hex Output ดังนี้ คือ 
 

 Binary File ประกอบดวย BIN8, BIN16, BIN32 เปน Output File แบบ Binary 8, 16 และ 32 
 Intel Hex File  ประกอบดวย INT8 และ INT16 เปน Output File แบบ Intel Hex ขนาด 8 บิต 
และ 16 บิต ตามลําดับ 
 Motorola Hex File ประกอบดวย MOT8, MOT16, MOT32 เปน Output File แบบ Motorola Hex 
ขนาด 8 บิต, 16 บิต และ 32 บิต 
 


